Encoder Pro
Copyright © 2006 Ingenix, Inc.

Encoder Pro

All rights reserved. Printed in the United States of America. This document is designed to be an accurate and authoritative source of information about Encoder Pro and its suite mates. Every effort has been made to verify the accuracy of the information, and all information is believed reliable at the time of publication. However, absolute accuracy cannot be guaranteed. Since the policy of Ingenix is to make continuous improvements, this document is subject to change without notice. All attempts are made to ensure that the information presented in this document is correct. However, if you should find any error, please notify an Ingenix representative. No liability, expressed or implied, will be assumed by Ingenix or its affiliates for any damage resulting from the use of the information in this manual.

AMA Notice

CPT Codes, descriptions, and other CPT material only are copyright 2005 American Medical Association (AMA). All Rights Reserved. No fee schedules, basic units, relative values or related listing are included in CPT. AMA does not directly or in directly practice medicine or dispense medical services. AMA assumes no liability for data contained or not contained herein

NTIS Notice

The responsibility for the content of any ‘National Correct Coding Policy’ included in this product is with the Centers for Medicare & Medicaid Services (CMS), formerly known as the Health Care Financing Administration or HCFA and no endorsement by the AMA is intended or should be implied. The AMA disclaims responsibility for any consequences or liability attributable to or related to any use, nonuse or interpretation of information contained in this product.

The software and documentation is provided with restricted rights. The Use, Duplication, or Disclosure by the Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFAR 252.227-7013 or restricted rights clauses at 48 CFR 52.227-19 or 52.227-14, as applicable. Contractor/Manufacturer is Ingenix, 2525 Lake Park Blvd, West Valley City, UT, 84120.
Contents

WELCOME ..................................................................................................................................................................1

About Ingenix .......................................................................................................................................................2

Getting Help ......................................................................................................................................................2

Software Features .................................................................................................................................................2

  What’s New in Encoder Pro? ..........................................................................................................................5

  Data Versions.................................................................................................................................................5

What’s New Files and Tables ..............................................................................................................................6

Enhancements in Encoder Pro ................................................................................................................................7

Upgrade Benefits ................................................................................................................................................7

Hardware Requirements .........................................................................................................................................7

Operating System Requirements .......................................................................................................................8

About the Software ................................................................................................................................................8

Encoder Pro Window ........................................................................................................................................9

PRODUCT SET-UP ..................................................................................................................................................10

Logins and Passwords ........................................................................................................................................10

  User Logins ................................................................................................................................................10

  First Time Logins .......................................................................................................................................10

  Administrator Logins .................................................................................................................................11

  User Passwords .........................................................................................................................................11

  Changing User Passwords ........................................................................................................................11

  Invalid Logins and Passwords ....................................................................................................................11

Preferences .........................................................................................................................................................11

  Copy Tab ....................................................................................................................................................11

  Search Tab ...............................................................................................................................................12

  View Tab ................................................................................................................................................13

  Network Tab (Multiple User Versions) .......................................................................................................13

  Data Versions Tab (EXPT and PRO only) ..................................................................................................14

Launching From the Taskbar ................................................................................................................................14

Data Updates ........................................................................................................................................................15

Importing Global Bookmarks and Sticky Notes from a Previous Version ......................................................16

Display Properties .............................................................................................................................................16

SEARCHING FOR CODES ....................................................................................................................................18

Looking up Codes Quickly ................................................................................................................................18

The Black Toolbar ..............................................................................................................................................18
New Codes................................................................................................................................. 19
Revised Codes............................................................................................................................. 19
Deleted Codes............................................................................................................................... 19
Code Book Sections ...................................................................................................................... 20

Looking Up Codes That Have Color Symbols ................................................................................. 21
CPT Color Codes (not in CIF-I9) ..................................................................................................... 21
ICD-9 Vol. 1 Color Codes ............................................................................................................... 23
ICD-9 Vol. 3 Color Codes ............................................................................................................... 25
HCPCS Color Codes (not in CIF-I9) ............................................................................................... 27

Performing a Code Search ............................................................................................................... 29
Entering Search Criteria.................................................................................................................. 29
Tips For Entering Search Terms ..................................................................................................... 29
Determining Search Criteria........................................................................................................... 30
Criteria for CPT Codes .................................................................................................................. 30
Criteria for ICD-9-CM Codes ........................................................................................................ 30
Spell Checking Search Terms ......................................................................................................... 31
Viewing Search Results ................................................................................................................... 31
Viewing Additional Digit ICD-9-CM Codes .................................................................................... 32
Viewing CPT and HCPCS Codes .................................................................................................. 33
Narrowing Search Results.............................................................................................................. 33
Results Alert .................................................................................................................................. 33
Specifying Code Sets .................................................................................................................... 34
Specifying Code Type ..................................................................................................................... 34
Revert Button ............................................................................................................................... 36
Viewing Index Listing .................................................................................................................... 36
Viewing Codes in the Code Detail ................................................................................................. 37

CODE DETAIL .................................................................................................................................. 38

Selecting a Code from Code Detail ............................................................................................... 39
ICD-9-CM Code Detail ................................................................................................................... 39
CPT and HCPCS Code Detail ........................................................................................................ 40

CODE-SPECIFIC DIALOG BOXES ................................................................................................. 41

ICD-9-CM Vol. 1 Dialog Boxes ...................................................................................................... 41
ICD-9-CM Instructional Notes ........................................................................................................ 41
ICD-9-CM Annotations ..................................................................................................................... 42
DRG Crosscodes (not in STND) ...................................................................................................... 43
ICD-9 Vol. 1 Color Coding Legend ................................................................................................ 44
ICD-9-CM Vol. 3 Dialog Boxes

ICD-9-CM Annotations
ICD-9 Vol. 3 Crosscodes (EXPT and PRO only)
DRG Crosscodes (not in STND)
ICD-9 Vol. 3 Color Coding Legend

CPT Dialog Boxes

CPT Section Notes (not in CIFI9)
CPT Lay Descriptions (not in CIFI9)
CPT Modifiers (not in CIFI9)
CPT Crosscoder (EXPT and PRO only)
CPT CCI Unbundle Edits (EXPT and PRO only)
Tabs
CCI Data
LMRP Medical Necessity Edits (EXPT and PRO only)
Local Medical/Medicare Review Policy (LMRP)
Medically Necessary and Reasonable
Documentation
Reimbursement
National Policy
Focused Medical Review
National Coverage Determinations Edits (EXPT and PRO only)
Medically Necessary and Reasonable
Documentation
Reimbursement
National Policy
Medicare Physician Fee Schedule (EXPT and PRO only)
Special Coverage Instructions (not in CIFI9)
CPT Color Coding Legend (not in CIFI9)

HCPCS Dialog Boxes

HCPCS Section Notes (not in CIFI9)
HCPCS Annotations (not in CIFI9)
HCPCS Modifiers (EXPT and PRO only)
HCPCS Crosscodes (EXPT and PRO only)
HCPCS CCI Unbundle Edits (EXPT and PRO only)
Tabs
HCPCS Color Coding Legend (not in CIFI9)
USER TOOLS ............................................................................................................................................................69

Using Bookmarks ..........................................................................................................................................................69
  Updating Bookmarks................................................................................................................................................69
  Adding a New Bookmark .......................................................................................................................................70
    Shortcut .................................................................................................................................................................70
  Editing a Bookmark..................................................................................................................................................70
  Deleting a Bookmark...............................................................................................................................................71
  Importing Bookmarks from Previous Versions ........................................................................................................71

Using Sticky Notes ......................................................................................................................................................72
  View Only Check Boxes..........................................................................................................................................73
  Links to the Code Detail .........................................................................................................................................73
  Balloon Help............................................................................................................................................................73
  Color Code Box Links ..............................................................................................................................................73
  Sticky Notes Update ..............................................................................................................................................73
  Adding a New Sticky Note ....................................................................................................................................74
    Shortcut .................................................................................................................................................................74
  Sticky Note Indicator .............................................................................................................................................75
  Viewing or Editing an Existing Note ........................................................................................................................75
  Deleting an Existing Note.......................................................................................................................................76
  Importing Sticky Notes from Previous Versions ..................................................................................................76

Using the Notepad ......................................................................................................................................................76
  Notepad Fields ........................................................................................................................................................77
  Notepad Buttons: .....................................................................................................................................................77
  Adding Codes to the Notepad ...................................................................................................................................78
    To add a code to the Notepad from within the Notepad dialog box: ...............................................................78
    To add a code to the Notepad from the Code Detail: .........................................................................................78
    Shortcut .................................................................................................................................................................78
 Appending Modifiers ..................................................................................................................................................78
    To append a modifier to a code in the Notepad: .................................................................................................79
Duplicating Codes .......................................................................................................................................................79
Deleting Codes ...........................................................................................................................................................79
Sending Data to the Clipboard ..................................................................................................................................79

Using the Copy Function ...........................................................................................................................................79
  Copying Codes and Descriptions ..............................................................................................................................79
  Copying Text .............................................................................................................................................................80
  Copying to the Clipboard .........................................................................................................................................80
CCI Unbundle Conflicts Tab......................................................................................................................... 118

SYSTEM ADMINISTRATOR (ALL MULTIPLE-USER VERSIONS).....................................................................................121

System Administrator Login ................................................................................................................................. 121
System Administrator Logout.................................................................................................................................. 121
Changing the Administrator Password.................................................................................................................. 122
Preferences Dialog Box Network Tab .................................................................................................................. 122
User Maintenance (All Multi-User Versions).......................................................................................................... 123
Delete User ............................................................................................................................................................ 123
Reset Password ..................................................................................................................................................... 123

MENUS ....................................................................................................................................................................124

File Menu ................................................................................................................................................................. 124
Print (Ctrl+P) ......................................................................................................................................................... 124
Page Setup ............................................................................................................................................................ 124
E/M Assistant (Ctrl+E) (EXPT and PRO only) ........................................................................................................ 124
Administration ➤ Administrator Login (All Multi-User Versions) ............................................................................... 124
Administration ➤ Administrator Logout (All Multi-User Versions) ........................................................................... 124
Administration ➤ Change Admin Password (All Multi-User Versions) ................................................................. 124
Administration ➤ Change Password (All Multi-User Versions) .............................................................................. 125
Administration ➤ User Maintenance (All Multi-User Versions) ............................................................................. 125
Exit (Ctrl+Q) .......................................................................................................................................................... 125

Edit Menu ................................................................................................................................................................. 125
Copy (Ctrl+C) ........................................................................................................................................................ 125
Add ........................................................................................................................................................................ 125
Preferences ............................................................................................................................................................. 125
Select Carrier/Locality (EXPT and PRO only) ...................................................................................................... 125

View Menu ............................................................................................................................................................... 126
Index Listing ........................................................................................................................................................ 126
Bookmarks ............................................................................................................................................................ 126
Sticky Notes .......................................................................................................................................................... 126
Notepad ................................................................................................................................................................. 126
New Codes ............................................................................................................................................................ 126
Revised Codes ....................................................................................................................................................... 126
Deleted Codes ....................................................................................................................................................... 126
CPT Color Codes (not in CIFI9) ........................................................................................................................... 126
ICD-9 Vol. 1 Color Codes .................................................................................................................................... 126
ICD-9 Vol. 3 Color Codes .................................................................................................................................... 127
HCPCS Color Codes (not in CIFI9) .......................................................................................................... 127
Code Book Sections ................................................................................................................................. 127

ICD-9 Vol. 1 Menu .................................................................................................................................. 127
ICD-9 Section Notes .................................................................................................................................. 127
Annotations ............................................................................................................................................... 127
DRG Crosscodes (not in STND) .............................................................................................................. 127
Color Coding Legend ............................................................................................................................... 127
Previous Codes ....................................................................................................................................... 127
Next Codes ............................................................................................................................................... 127

ICD-9 Vol. 3 Menu .................................................................................................................................. 128
Annotations ............................................................................................................................................... 128
ICD-9 Vol. 3 to CPT (EXPT and PRO only) .............................................................................................. 128
DRG Crosscodes (not in STND) .............................................................................................................. 128
Color Coding Legend ............................................................................................................................... 128
Previous Codes ....................................................................................................................................... 128
Next Codes ............................................................................................................................................... 128

CPT Menu (not in CIFI9) .......................................................................................................................... 129
CPT Section Notes .................................................................................................................................. 129
Lay Descriptions ..................................................................................................................................... 129
Modifiers (EXPT and PRO only) ............................................................................................................. 129
Crosscoder (EXPT and PRO only) ........................................................................................................... 129
CCI Unbundle Edits (EXPT and PRO only) ............................................................................................. 129
Local Medical Review Policies (EXPT and PRO only) ........................................................................... 129
National Coverage Determinations (EXPT and PRO only) .................................................................... 129
Medicare Fee Schedule (EXPT and PRO only) ....................................................................................... 129
Medicare Policy ...................................................................................................................................... 130
Color Coding Legend ............................................................................................................................... 130
Previous Codes ....................................................................................................................................... 130
Next Codes ............................................................................................................................................... 130
Carriers with LMRP (EXPT and PRO only) ............................................................................................ 130

HCPCS Menu (not in CIFI9) ..................................................................................................................... 130
HCPCS Section Notes ............................................................................................................................... 130
Annotations ............................................................................................................................................... 130
Modifiers (EXPT and PRO only) ............................................................................................................. 130
Crosscoder (EXPT and PRO only) ........................................................................................................... 131
CCI Unbundle Edits (EXPT and PRO only) ............................................................................................. 131
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Medical Review Policies (EXPT and PRO only)</td>
<td>131</td>
</tr>
<tr>
<td>National Coverage Determinations (EXPT and PRO only)</td>
<td>131</td>
</tr>
<tr>
<td>Medicare Policy</td>
<td>131</td>
</tr>
<tr>
<td>Color Coding Legend</td>
<td>131</td>
</tr>
<tr>
<td>Previous Codes</td>
<td>131</td>
</tr>
<tr>
<td>Next Codes</td>
<td>131</td>
</tr>
<tr>
<td>Carriers with LMRP (EXPT and PRO only)</td>
<td>131</td>
</tr>
<tr>
<td>Update Menu</td>
<td>131</td>
</tr>
<tr>
<td>History Menu</td>
<td>131</td>
</tr>
<tr>
<td>Help Menu</td>
<td>132</td>
</tr>
<tr>
<td>Coding</td>
<td>132</td>
</tr>
<tr>
<td>Program Help (Ctrl+H)</td>
<td>132</td>
</tr>
<tr>
<td>Environment Information</td>
<td>132</td>
</tr>
<tr>
<td>AMA Copyright (not in CIFI9)</td>
<td>132</td>
</tr>
<tr>
<td>License Agreement</td>
<td>132</td>
</tr>
<tr>
<td>Data Version</td>
<td>132</td>
</tr>
<tr>
<td>About</td>
<td>132</td>
</tr>
<tr>
<td>Right-click Add Menu</td>
<td>133</td>
</tr>
<tr>
<td>Add To Global Bookmarks</td>
<td>133</td>
</tr>
<tr>
<td>Add To Personal Bookmarks</td>
<td>133</td>
</tr>
<tr>
<td>Add To Global Sticky Notes</td>
<td>133</td>
</tr>
<tr>
<td>Add To Personal Sticky Notes</td>
<td>133</td>
</tr>
<tr>
<td>Add To Notepad</td>
<td>133</td>
</tr>
<tr>
<td>View Carriers with LMRP (EXPT and PRO only)</td>
<td>133</td>
</tr>
<tr>
<td>TOOLBAR</td>
<td>134</td>
</tr>
<tr>
<td>Add</td>
<td>134</td>
</tr>
<tr>
<td>Bookmarks</td>
<td>134</td>
</tr>
<tr>
<td>Sticky Notes</td>
<td>134</td>
</tr>
<tr>
<td>Notepad</td>
<td>134</td>
</tr>
<tr>
<td>Print</td>
<td>134</td>
</tr>
<tr>
<td>Notes</td>
<td>134</td>
</tr>
<tr>
<td>Annotations</td>
<td>134</td>
</tr>
</tbody>
</table>
Modifiers .......................................... 135
Crosscodes ......................................... 135
CCI Unbundle Edits ................................. 135
LMRP Edits .......................................... 135
NCD Edits ............................................. 135
CMS Fee Schedule ................................. 135
CMS Policy .......................................... 135
DRG Crosscodes .................................... 135
Color Coding Legend ......................... 136
Help .................................................... 136
Welcome

Welcome to Encoder Pro - the powerful medical coding solution. Encoder Pro searches ICD-9-CM, CPT®, and HCPCS Level II code sets, provides information from Medicare policies and Ingenix publications, and helps you confidently select the proper codes quickly and accurately.

The following products are available in Encoder Pro:

- Code It Fast I-9 (CIFI9)
- Encoder Pro (STND)
- Encoder Pro Professional (PRO)
- Encoder Pro Expert (EXPT)

All features explained in this User’s Manual apply to all products in Encoder Pro unless otherwise noted. Feature availability per product is noted in the table below:

**Code It Fast I-9**
- ICD-9-CM Volume 1 and 3 codes, ICD-9-CM instructional notes, AHA Coding Clinic references, and annotations
- ICD-9-CM to DRG and MDC crosswalk
- Enter search terms
- Search History
- Copying Codes to the Notepad
- New, Revised, and Deleted Codes
- Code Book Section lookup
- Index Listing of ICD-9-CM code book
- All color codes associated with the selected code
- Customized Sticky Notes and Bookmarks
- Invalid codes, unspecified codes, CC exclusions
- Data Updates
- Print Reports
- Taskbar search tool

**Encoder Pro**
All the above (except ICD-9-CM to DRG and MDC crosswalk) with these added features:
- CPT Lay Descriptions
- CPT Section Notes, CPT Assistant References, Special Coverage Instructions
- CPT color codes identify add-on, modifier –51 exempt, age and sex specific codes
- HCPCS color codes identify codes carrying quantity, coverage, and policy flags.
- HCPCS Notes, Medicare Coverage Instructions
**Encoder Pro Professional**

All the above with these added features:

- CPT Modifiers
- HCPCS Modifiers
- LMRP Medical Necessity Edits
- National Coverage Determinations Edits
- CCI Unbundle Edits
- Surgical Crosscoder for CPT to ICD-9-CM, ICD-9-CM to CPT, HCPCS to CPT, CPT to Dental codes, CPT to CPT Anesthesia, CPT to CPT Medicine, CPT to CPT Radiology, CPT to CPT Lab
- E/M Assistant
- Medicare Physician Fee Schedule dialog box

**Encoder Pro Expert**

All the above with these added features:

- Fee Calculation by Locality
- Exam Calculator
- Compliance Edit
- Edit Reports
- Select Multiple CCI Versions

---

**ABOUT INGENIX**

Ingenix is a recognized leader in providing accurate and meaningful healthcare data and information. Ingenix has the reputation for providing authoritative and comprehensive coding, compliance, billing and benchmarking tools. Ingenix has the ability to empower organizations, giving them control over profits, consistent performance and better quality of care. The power of Ingenix expertise offers an unparalleled resource for your financial, clinical, and operational needs.

---

**GETTING HELP**

Consult this User’s Manual. It explains all product features, and guides you through all basic functionality. Note that certain features may not be available to you, depending on which product you purchased from Encoder Pro.

Access the online help by selecting an item from the Help menu or clicking the button on the black toolbar. Online help includes information about how to use the program and provides clinical information about coding.

Call (800) 765-6797 to speak with an Ingenix software technical support representative.

---

**SOFTWARE FEATURES**

**CodeLogic™ Search Technology**

Simultaneous code search across ICD-9-CM, CPT, and HCPCS code sets. Your search results can be limited to just one code set, a combination of two, or all three. Search results and code information display on one screen. Code It Fast I-9 returns results on ICD-9-CM volumes 1 and 3 only.

**Entering Search Terms**

You can enter up to four search terms or term abbreviations to allow you to narrow down the results when you first initiate a search. An automatic spell check feature ensures that
you enter valid terms.

Search Type

You can set the search preferences to limit your searches to certain code sets (e.g., just ICD-9-CM Vol. 1 and CPT) and define the parameters of your search results.

Narrowing Search Results

You can narrow the search results by clicking the Narrow button. Narrow Search features let you specify the type of code by section (e.g., surgery, radiology, hospital procedure, etc.). You can use the Narrow Search as often as necessary to pare down the results to specific code sections.

Viewing Search Results

The Tabular Results show relevant codes that match your search criteria. The number of code matches found is referenced on screen. Codes are displayed so that the most likely codes are listed first (by rank). Fourth- and fifth-digit ICD-9-CM codes are grouped as sublevels under each primary code. CPT and HCPCS codes are grouped as sublevels under the corresponding section or subsection, identified by the range of codes in that subsection.

Index Listing

You can view matches to your search terms in the indexes of the ICD-9-CM, CPT, and HCPCS books. The Index Listing window displays index terms and corresponding codes for the current search terms.

Code Detail

Select any code listed in the Tabular Results to view the full description for the code and all neighboring codes in the adjacent Code Detail. For ICD-9-CM codes, the Code Detail also shows excludes and includes notes, as well as “code first” and “code also” references. CPT and HCPCS codes in the Code Detail are grouped by section/subsection.

Code-Specific Dialog Boxes for ICD-9-CM

You can easily view ICD-9-CM instructional notes, AHA Coding Clinic references, and annotations. You can also view CPT crosscodes for ICD-9-CM Vol. 3 codes and (for all products except STND) DRG Crosswalks for ICD-9-CM Vol. 1 codes.

Code-Specific Dialog Boxes for CPT (All products except Code It Fast I-9)

You can easily view lay descriptions, CPT Assistant references, AMA guidelines, and modifiers for the selected CPT code. For EXPT and PRO, you can also view primary procedure codes for add-on codes, surgical and anesthesia crosscodes, Medicare Physician Fee Schedule information, and unbundle edits from Medicare’s Correct Coding Initiative.

Code-Specific Dialog Boxes for HCPCS (All products except Code It Fast I-9)

You can easily view annotations, section notes, modifiers, and coverage instruction references from the Medicare Carrier’s Manual and the Coverage Issues Manual for the selected HCPCS code.
The History Menu

The History menu lists a trail of up to 15 previously viewed codes. This makes it easy to go back to a previous code selection for the current session.

Bookmarks

With Bookmarks you can store, amend, and catalog lists of frequently used codes.

Copying Codes

You can copy codes, descriptions, and modifiers into the Windows clipboard to be pasted into other Windows programs. The Notepad lets you send multiple codes to the clipboard at one time. You can set preferences to copy the code only, or the code and its description.

Deleted Codes

The Deleted Codes dialog box appears whenever you enter a deleted code or when you access it through the View menu. This dialog box lists all the deleted codes for each applicable code set and any applicable cross-reference codes.

Color Codes Dialog Boxes

You can quickly look up all codes that have a color code associated with them by viewing a sorted list in the applicable dialog box from the View menu.

Sticky Notes

You can add/edit your own comments to codes with sticky notes. Each code with a sticky note attached is flagged for user reference.

Printing

You can print the code information that appears in any dialog box.

E/M Clinical Examples (All products except Code It Fast I-9)

Displays examples from Appendix D of the CPT Book for the CPT Evaluation and Management Codes.

Modifier Place of Setting (All products except Code It Fast I-9)

Indicates which CPT or HCPCS modifiers are approved for use in ASC settings.

LMRP Risk Compliance Edit (Expert and Professional only)

Runs a compliance edit for coding conflicts affecting the ICD-9-CM, CPT and/or HCPCS codes.

National Coverage Determinations Edits (Expert and Professional only)

Runs a compliance edit for coding conflicts affecting the ICD-9-CM, CPT and/or HCPCS codes under National Coverage Determinations.

What’s New in Encoder Pro?
What’s New in Encoder Pro?

• Data versions

Data Versions

See the Data Versions dialog box from your product’s Help menu for a complete list of applicable data versions.
## WHAT’S NEW FILES AND TABLES

<table>
<thead>
<tr>
<th>CPT Category II Codes</th>
<th>Performance Measurement Set</th>
<th>Release/Implemented Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>0001F Blood pressure, measured</td>
<td>Chronic Stable Coronary Artery Disease (CAD)</td>
<td>Released July 1, 2003 Implemented January 1, 2004</td>
</tr>
<tr>
<td>0008F ACE inhibitor therapy, prescribed</td>
<td>Chronic Stable Coronary Artery Disease (CAD)</td>
<td>Released July 1, 2003 Implemented January 1, 2004</td>
</tr>
<tr>
<td>0009F Anginal symptoms and level of activity, assessed</td>
<td>Chronic Stable Coronary Artery Disease (CAD)</td>
<td>Released July 1, 2003 Implemented January 1, 2004</td>
</tr>
<tr>
<td>0010F Anginal symptoms and level of activity, assessed using a standardized instrument (e.g., Canadian Cardiovascular Society Classification — CCSC—System, Seattle Angina Questionnaire—SAQ)</td>
<td>Chronic Stable Coronary Artery Disease (CAD)</td>
<td>Released July 1, 2003 Implemented January 1, 2004</td>
</tr>
<tr>
<td>0002F Tobacco use, smoking, assessed</td>
<td>Preventative Care and Screening Physician Performance Measurement Set</td>
<td>Released July 1, 2003 Implemented January 1, 2004</td>
</tr>
<tr>
<td>0003F Tobacco use, non-smoking, assessed</td>
<td>Chronic Stable Coronary Artery Disease (CAD)</td>
<td>Released July 1, 2003 Implemented January 1, 2004</td>
</tr>
<tr>
<td>0004F Tobacco use cessation intervention, counseling</td>
<td>Chronic Stable Coronary Artery Disease (CAD)</td>
<td>Released July 1, 2003 Implemented January 1, 2004</td>
</tr>
<tr>
<td>0005F Tobacco use cessation intervention, pharmacologic therapy</td>
<td>Chronic Stable Coronary Artery Disease (CAD)</td>
<td>Released July 1, 2003 Implemented January 1, 2004</td>
</tr>
<tr>
<td>0011F Oral antiplatelet therapy prescribed (e.g., aspirin, clopidogrel/Plavix, or combination of aspirin and dipyidamole/Aggrenox)</td>
<td>Chronic Stable Coronary Artery Disease (CAD)</td>
<td>Released July 1, 2003 Implemented January 1, 2004</td>
</tr>
<tr>
<td>0006F Statin therapy, prescribed</td>
<td>Chronic Stable Coronary Artery Disease (CAD)</td>
<td>Released July 1, 2003 Implemented January 1, 2004</td>
</tr>
<tr>
<td>0007F Beta-blocker therapy, prescribed</td>
<td>Chronic Stable Coronary Artery Disease (CAD)</td>
<td>Released July 1, 2003 Implemented January 1, 2004</td>
</tr>
</tbody>
</table>
ENHANCEMENTS IN ENCODER PRO

Four CCI versions are available in Encoder Pro Expert and Professional. CCI data will be available to download the latest CCI data version. A new Updates menu option is available that opens the Data Updates screen where the new CCI version displays when the update is available to download. With a new CCI version update, the oldest CCI version will drop from the program maintaining four versions of CCI.

Version selections are available in Preferences, Data Versions.

Data Update is an enhancement that will be enabled when data is available. It provides immediate access to new data sets. The Data Update dialog box lists only the specific data available in your Encoder Pro program. Updates menu option opens the Data Updates dialog box that contains the new data sets. Single users and administrators for multi-user versions will be able to update the data.

Transitional Adjustment to Medicare, Payment for Certain Drug, Administration Services, Section 303(a)(4) of MPDIMA provides for a transitional adjustment to Medicare payment for drug administration services to reflect implementation of the amendments made by section 303 of MPDIMA affecting Medicare’s payments for drugs. Specifically, section 303(a)(4) of MPDIMA requires Medicare to increase the physician fee schedule amounts otherwise determined by 32 percent for 2004 and 3 percent for 2005. Payment will be determined for CPT codes:

- 90780 through 90781
- 90782 through 90788
- 96400
- 96408 through 96425
- 96520
- 96530

based on the work, practice expense and malpractice RVUs shown in Addendum B and the 2004 CF of $37.3374.

Consistent with section 303(a)(4) of MPDIMA, the physician fee schedule amount will be increased by an additional 32 percent for 2004. (The physician fee schedule amounts applicable in 2005 will be increased by 3 percent.)

UPGRADE BENEFITS

If you receive a Code Not Supported message box, you are a Code It Fast I-9 customer and have attempted to use a feature not supported by Code It Fast 19. Ingenix recommends you consider upgrading to one of our more powerful products.

HARDWARE REQUIREMENTS

<table>
<thead>
<tr>
<th>Product</th>
<th>Recommended Requirements</th>
<th>Minimum Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encoder Pro Expert and</td>
<td>64 MB RAM</td>
<td>32 MB RAM</td>
</tr>
<tr>
<td>Encoder Pro Professional</td>
<td>PII 233 MHz processor</td>
<td>PII 166 MHz processor</td>
</tr>
<tr>
<td></td>
<td>800 X 600 SVGA</td>
<td>800 X 600 SVGA</td>
</tr>
<tr>
<td></td>
<td>100 MB disk space</td>
<td>100 MB disk space</td>
</tr>
</tbody>
</table>
### Product Requirements

<table>
<thead>
<tr>
<th>Product</th>
<th>Recommended Requirements</th>
<th>Minimum Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encoder Pro Standard and Code It Fast I-9</td>
<td>16-bit color</td>
<td>16-bit color</td>
</tr>
<tr>
<td></td>
<td>64 MB RAM</td>
<td>32 MB RAM</td>
</tr>
<tr>
<td></td>
<td>PII 233 MHz processor</td>
<td>PI 166 MHz processor</td>
</tr>
<tr>
<td></td>
<td>800 X 600 SVGA</td>
<td>800 X 600 SVGA</td>
</tr>
<tr>
<td></td>
<td>60 MB disk space</td>
<td>60 MB disk space</td>
</tr>
<tr>
<td></td>
<td>16-bit color</td>
<td>16-bit color</td>
</tr>
</tbody>
</table>

### OPERATING SYSTEM REQUIREMENTS

Encoder Pro has been tested on the following operating systems.

- Windows 95C and above
- Windows 98
- Windows ME
- Windows 2000
- Windows NT versions 4.x and 2000
- Windows XP

### ABOUT THE SOFTWARE

All Encoder Pro products are Windows-sharable programs, not client/server programs. They are designed with the ability to have multiple users, but are not a traditional network product. Encoder Pro can execute on top of a Novell environment with a Windows Operating System (OS).
ENCODER PRO WINDOW

Open menus on the menu bar to select commands

Type search criteria in the Search Prompt

Click Narrow results by section to choose additional criteria to narrow search results

Click buttons on the toolbar to access information or perform commands

Select and click View to access new, deleted, and revised codes and the code book sections

View online help

View section headers from the associated CPT, HCPCS, or ICD-9-CM book

The Code Detail displays the full description and all neighboring codes for the selected code

View color code symbols associated with the selected code in the color code box

CPT only © 2005 American Medical Association. All Rights Reserved.
Product Set-up

LOGINS AND PASSWORDS

This section applies only to those using the multi-user versions of Encoder Pro.

User Logins

The User Login dialog box appears every time the program is launched. Once properly logged in, you are then identified on the system and will have access to personal sticky notes and bookmarks. After closing this dialog box, the program then launches.

First Time Logins

If your System Administrator has not yet added your User Name, this dialog box allows you to accomplish a first time login. However, if you have already logged in once, using a different User Name to bypass security is NOT a good idea. Doing so will prevent you from accessing your personal Bookmarks and Sticky Notes.

Note: Your User Name may not be less than 4 characters or more than 10 characters. If you violate this convention, you will receive an error message.
Administrator Logins

Refer to System Administrator Login for information regarding Administrator logins and privileges.

User Passwords

A minimum of four characters is required for user password, and they are not case-sensitive. If you selected Remember User Name and password in your previous login session, then these fields will be populated in future logins.

Changing User Passwords

You can change your User Password by selecting Change Password from the File menu’s Administration submenu. If you are logged in as an Administrator and want to change your User Name, log out as Administrator first.

Invalid Logins and Passwords

If you enter an invalid password in the User Login or Administrator Login dialog boxes, you will be notified your attempt was unsuccessful via a message box.

PREFERENCES

This section explains how to set the preferences in order to modify how your product behaves. You access the various Preferences tabs by selecting Preferences from the Edit menu.

Copy Tab

When you copy code information from the Code Detail or Notepad, the default is to copy the code and the full description. However, in the Copy tab of the Preferences dialog box, you can decide what pieces of data to copy:

- The code and full description (click the radio button).
- The code (number) only (click the radio button).
- The dates of service (check the box). The dates of service feature works only if you are copying data from the Notepad (or Compliance Notepad) and you have entered dates of service there.

From the Description Length drop-down list, you also choose what format you’d like the code description to be presented:

- The full description
- A 48-character description
- A 35-character description.

The shortened descriptions are abbreviated rather than truncated (the program logically abbreviates the description rather than to simply cut it off after the 35th or 48th character).

For further information regarding copying and using the clipboard, refer to Copying to the clipboard on page 80.
Search Tab

When you first install an Encoder Pro product, the default preference is to include all code sets when performing a code search:

- ICD-9-CM Vol. 1
- ICD-9-CM Vol. 3
- CPT Codes
- HCPCS codes

You can use the Preferences’ Search tab to change that default and limit searches to a particular code set (or code sets):

1. From the Preferences dialog box, make sure that only those check box(es) of the code set(s) you want to search are marked.
2. Select a check box to include the code set; clear the check box to exclude the code set.

When you enter search criteria, the program searches both the standard code list and the Index for matches.
View Tab

There are three preferences to determine within this Preference dialog box tab.

- **View search results according to.** There are two selections in this drop-down list. **Weighted ranking** arranges search results so the codes that best fit your search criteria are listed first. This is the default option. **Alphanumeric listing** arranges code results in ascending alphanumeric order.

- **Display Edit Bookmark dialog each time a bookmark is assigned to a code.** A check in this box specifies you want the Edit Bookmark dialog box to open whenever a bookmark is added to a code. The default is for this box to be checked.

- **Multi-User Versions Only.** This area is for use by multi-user version customers. From here you specify which sticky note should display in the View Sticky Note dialog box when a code has both a global sticky note and a personal sticky note assigned to it. The default is for the global note to take precedence as the primary note.

- **Network Tab (Multiple User Versions)**

  The **Network** tab within the Preferences dialog box is only available if you are logged in as a System Administrator. It gives the System Administrator the ability to activate or inactivate the following functions for **ALL** users: Personal Sticky Notes:

  - Personal Bookmarks
  - Section Notes
  - Annotations
  - Modifiers
  - Unbundle Edits
  - Crosscodes
  - CMS Policy
  - Medicare Fee
  - DRG Crosscodes
  - Click the check box for any feature to deselect it; click again to reselect it.
Note: Some of the check boxes discussed in the paragraph above are not available depending on which Encoder Pro product you purchased.

The **Network** tab also has a **Set Idle Time Shutdown** spin box that allows the System Administrator to specify how long the program can remain idle before the product shuts itself down.

Data Versions Tab (EXPT and PRO only)

This preference tab has an arrow-down box to select one of the last four CCI data versions in Encoder Pro EXPT and PRO only. The default is the latest version. The program closes when the version is changed. The new version selection appears when Encoder Pro is launched.

**Launching From the Taskbar**

There is an option that can be installed to launch Encoder Pro product from the Taskbar. This option is separately installed.

1. From the Explore menu select C:\Ingenix\EncoderPro
2. Double-click on IngenixToolBar.exe
3. Follow the installation instructions.
After installation is complete, an Ingenix icon displays on the Start Taskbar to browse for codes when Ingenix Tools is selected.

1. Right-click on the Start Taskbar
2. Select Toolbars, Ingenix Tools
3. The Ingenix icon displays.
4. Enter a code in the search box and press the enter key.
5. The product login box displays.
6. Add User Name and Password and select the OK button.
7. The Code Detail for the selected code is displayed.

Turn off the Ingenix Toolbar.

1. Right-click on the Start Taskbar
2. Select Toolbars, Ingenix Tools to uncheck the option and the icon is removed from the Taskbar.

**DATA UPDATES**

*This Enhancement will be enabled when data is available.*

Select **Updates, Data Updates** from the menu to display the Data Updates dialog box. Only the data sets that are applicable to the features in your Encoder Pro program are shown in the Name and Description fields. The Update button is available to single users and administrators of multi-user versions. Click the Update button to update your data sets.
Administrators and single users perform the data updates.

1. All external communication uses Internet read access via HTTP.
2. You must have access to http://www.ingenixdataupdates.com
3. HTTP communication uses the preconfigured Internet access parameters in the workstation.

**IMPORTING GLOBAL BOOKMARKS AND STICKY NOTES FROM A PREVIOUS VERSION**

All Bookmarks and Sticky Notes you created in previous versions of Encoder Pro or Code It Fast are automatically imported into this product.

**Exception:** Bookmarks and Sticky Notes from versions 3.0, and those from versions older than 2.4.1 are not automatically imported. If you have questions, please contact Technical Support at (800) 765-6797.

**DISPLAY PROPERTIES**

This dialog box appears upon launch (except for Windows 95 users) of your Encoder Pro suite product only if the product detects less than optimal Display settings. The minimum recommended settings are 16-bit color and 800 x 600 screen area.
If the Display Properties dialog box appears, you may use it to change your settings to our optimal requirements. If you choose to change your settings via this dialog box, you will be asked whether you want to revert back to your original settings when you exit your Encoder Pro suite program.

If you choose not to change your color settings, please be advised the product still functions, but the colors will not display correctly. If you choose not to change your screen area (resolution) settings, navigation within the product will be difficult, but not impossible.

Ingenix recommends changing your settings if this dialog box appears.

**Windows 95 Users:** The recommended settings apply. However, the Display Properties dialog box does not appear for you. To change your color settings, manually adjust them through your Control Panel’s **Display** option **Settings** tab.
Searching for Codes

Looking up Codes Quickly

Click any code in the Tabular Results to go to that code in the Code Detail. There are four additional ways to locate a code in the listing:

- Enter the code number at the Search box and click either the Enter key or the Search button (refer to Performing a Code Search for instructions).
- A list of codes that you have selected during the current lookup session is listed in the History menu. Use the trail in the History menu to go back to codes already selected. This code trail shows the 15 latest code selections, with the most recent at the top. The History menu shows codes entered as number searches as well as the selected codes.
- Select codes from the Bookmarks dialog box.
- Select codes from the Sticky Notes dialog box.

The Black Toolbar

Another feature provided to assist you in code lookup is the black toolbar.

At the far left, the Code Search drop-down list that allows you to determine if your search looks at all codes, or a specific code set (CPT, HCPCS, ICD-9-CM Vol. 1, or ICD-9-CM Vol. 3). You define what you mean by All Code Sets in the Search tab of the Preferences dialog box.

The Search box is used to enter search terms. You can also type in a valid code number to bypass the search and go directly to the Code Detail.

Click the Search button to the right of the Search Box, or click the Enter key to initiate the search.

The drop-down list on the right side of the black toolbar provides four ways to quickly access New Codes, Revised Codes, Deleted Codes, and Code Book Sections. Make your selection and then click the View button to access the dialog boxes.
New Codes

This dialog box shows all new codes, sorted with tabs by code set. It can also be accessed via the View menu. Double-clicking on the pink code number brings up that code in the Code Detail, but the dialog box remains active in the foreground. Single clicking the pink code and then clicking the Select button closes the dialog box and takes you directly to that code in the Code Detail.

Revised Codes

This dialog box shows all codes that have been revised, sorted with tabs by code set. It can also be accessed via the View menu. Double-clicking on the pink code number brings up that code in the Code Detail, but the dialog box remains active in the foreground. Single clicking the pink code and then clicking the Select button closes the dialog box and takes you directly to that code in the Code Detail.

Deleted Codes

If you enter a deleted code number in the Search Prompt, or if you select Deleted Codes from the View menu, the Deleted Codes dialog box appears. It is also accessed by selecting Revised Codes on the drop-down list on the right side of the black toolbar and then clicking the View button next to it.
Deleted codes are maintained for the years 1998 through the current year. The dialog box displays codes deleted prior to 1998 that are still referenced in the CPT Book. The Deleted Codes dialog box shows deleted codes, the year each code was deleted, and any cross-references. There are pink cross-reference codes in the third column. Double-click the pink code number to go to that code in the Code Detail, but the dialog box remains active in the foreground. Click the Cancel button to exit the dialog box.

The dialog box contains a separate tab for each code set. Codes in each set are arranged alphanumerically by code. If you are viewing this dialog box because you entered a deleted code at the Search box, the deleted code you entered is selected, but you can scroll through the list to view other deleted codes.

**Code Book Sections**

This dialog box gives you all of the convenience of looking up codes by section, just as they are arranged in the Contents pages of the ICD-9-CM, CPT and HCPCS code books. It is also accessible through the View menu’s **Code Book Sections**. It presents you a table of contents for the code books with the range of codes that are listed in each section. Click on the Code Range to go to the first code in that range in the Code Detail.

There are four tabs representing CPT, HCPCS, ICD-9-CM Vol. 1, and ICD-9-CM Vol. 3. Each tab allows you to see which code ranges are in each section and subsection of the code books.

To link from this dialog box to access the first code of any range of codes, double-click it or single click it and then click the Select button.
LOOKING UP CODES THAT HAVE COLOR SYMBOLS

The CPT, ICD-9 Vol. 1 and Vol. 3, and HCPCS Color Codes dialog boxes found under the View menu let you see codes that are assigned a certain color code. For example, you can quickly reference all ICD-9-CM Vol. 1 or Vol. 3 codes that are new and/or revised for the current year. Or, you can see all CPT Codes that are add-on codes. These dialog boxes are for reference only and do not support printing.

Note: Not all color codes are shown in these dialog boxes. For example, you will not find all codes that are commonly miscoded within these boxes.

CPT Color Codes (not in CIF-I9)

To open the CPT Color Code dialog box, select **CPT Color Codes** from the View menu.

This dialog box allows you to look up all CPT codes assigned color codes. It has tabs for New, Revised, Add-on, and -51 Exempt.

All six subordinate tabs contain a **Find** field that acts as a Go To button to maneuver within the codes in a given tab. This is not a “search” filter, and only accepts from 1 to 5 digits.

The data presented in these five tabs is the same no matter what code has been selected in the Code Detail or Tabular Results.

This dialog box contains magenta code number links that take you to the appropriate code in the Code Detail. You can access the links by double-clicking or by selecting them and then clicking the **Select** button.

**New.** The New tab shows all new CPT codes and their descriptions.
Revised. The Revised tab shows all revised CPT codes and their descriptions.

Add-on. The Add-on tab shows all CPT Add-on codes. It has three columns. The Code column shows all CPT Add-on codes. The Type column lists whether add-on codes have been defined by Ingenix or the AMA. The Description column gives the code’s description. You can sort this information by any of the three columns.

-51 Exempt. The -51 Exempt tab shows all CPT codes and their descriptions that should not be used with Modifier -51.
ICD-9 Vol. 1 Color Codes

To open the ICD-9 Vol. 1 Color Code dialog box, select ICD-9 Vol. 1 Color Codes from the View menu.

This dialog box allows you to look up all ICD-9-CM Vol. 1 codes assigned color codes. It has tabs for New, Revised, CC, Age, and Sex.

All five subordinate tabs contain a Find field that acts as a Go To button to maneuver within the codes in a given tab. This is not a “search” filter, and accepts from 1 to 6 digits (including the “V” and a decimal point if applicable).

The data presented in these five tabs is the same no matter what code has been selected in the Code Detail or Tabular Results.

This dialog box contains magenta code number links that direct you to the appropriate code in the Code Detail. You can access the links by double-clicking or by selecting them and then clicking the Select button.

Revised. The Revised tab shows all ICD-9-CM Vol. 1 codes that have been revised and their descriptions.

CC. The CC tab shows all Complication and Comorbidity codes (diagnoses that affect DRG assignments) and their descriptions.

Age. The Age tab shows all ICD-9-CM Vol. 1 codes that are age related. The Code column provides the ICD-9-CM Vol. 1 code. The Age column shows the applicable age category (e.g., Adult, Newborn). The Description column shows the code’s description. The data can be sorted by any of the three columns.
Sex. The Sex tab shows all ICD-9-CM Vol. 1 codes that are attributable to either a male or female diagnosis. The Code column provides the ICD-9-CM Vol. 1 code. The Sex column shows the gender for which the procedure is intended. The Description column gives the code’s description. The data can be sorted by any of the three columns.

ICD-9 Vol. 3 Color Codes

To open the ICD-9 Vol. 3 Color Code dialog box, select ICD-9 Vol. 3 Color Codes from the View menu.

This dialog box allows you to look up all ICD-9-CM Vol. 3 codes assigned color codes. It has tabs for New, Revised, OR, Sex, and Medicare.

All five subordinate tabs contain a Find field that acts as a Go To button to maneuver within the codes in a given tab. This is not a “search” filter, and accepts from 1 to 5 digits (including a decimal point).

The data presented in these five tabs is the same no matter what code has been selected in the Code Detail or Tabular Results.

This dialog box contains magenta code number links that take you to the appropriate code in the Code Detail. You can access the links by double-clicking or by selecting them and then clicking the Select button.


Revised. The Revised tab shows all ICD-9-CM Vol. 3 codes that have been revised and their descriptions.
OR. The OR tab shows all ICD-9-CM Vol. 3 Operating Room procedures and their descriptions.

Sex. The Sex tab shows all ICD-9-CM Vol. 3 codes that are attributable to either a male or female diagnosis. The Code column provides the ICD-9-CM Vol. 1 code. The Type column shows the gender for which the procedure is intended. The Description column gives the code’s description. The data can be sorted by any of the three columns.
**Medicare.** The Medicare tab shows all the ICD-9-CM Vol. 3 codes that are exclusive to Medicare. The **Code** column shows the ICD-9-CM Vol. 3 code. The **Coverage** column indicates whether the code is covered by Medicare. The **Description** column gives the code's description. The data can be sorted by any of the three columns.

**HCPCS Color Codes (not in CIF-I9)**

To open the HCPCS Color Code dialog box, select **HCPCS Color Codes** from the View menu.

This dialog box allows you to look up all HCPCS codes assigned color codes. It has tabs for New, Revised, Quantity, and Medicare. All four subordinate tabs contain a **Find** field that acts as a Go To button to maneuver within the codes in a given tab in this dialog box only. This is not a “search” filter, and accepts from 1 to 5 digits (including the alphanumeric).

**Note:** If a tab is not shown, that indicates there are no codes that fit that category for this release of Encoder Pro.

This dialog box contains magenta code number links that take you to the appropriate code in the Code Detail. You can access the links by double-clicking or by selecting them and then clicking the **Select** button.

**New.** The New tab shows all new HCPCS codes and their descriptions.

**Revised.** The Revised tab shows all HCPCS codes that have been revised and their descriptions.
Quantity. The Quantity tab shows all HCPCS codes which have any quantity associated with them and their descriptions (including amounts).

Medicare. The Medicare tab shows all the HCPCS codes that are exclusive to Medicare. The Code column shows the HCPCS code. The Coverage column indicates whether the code is used at the carrier’s discretion, or is not covered. The Description gives the code’s description. The data can be sorted by any of the three columns.
PERFORMING A CODE SEARCH

This section explains how to perform a code search. You learn how to determine and enter key search terms, and use the spell check feature.

Entering Search Criteria

The Search box is used to enter search terms and narrow down search results. You can also type in a valid code number to bypass the search and go directly to the Code Detail.

1. Type up to four key words or a code number at the Search Prompt. You do not have to click into the Search box in order to populate the text box. You can begin typing from anywhere in the main screen. Additionally, if you’ve entered something into the Search box and then decide to start another search using a different term, typing anywhere in the main screen replaces the older search term in place of the new term you are looking for. If you want to append another word to your search, you have to click into the Search box to modify or add to the term.

2. Click the Search button or your Enter key to initiate a search. The software searches all selected code set databases for a specific match based on the key words entered and the type of search option specified.

If you do not enter anything in the Search box and then click the Enter key, you receive a Search Term Error that reminds you something must be entered before a search can be initiated.

Tips For Entering Search Terms

- Choose search terms that uniquely identify the service or supply.
- Enter as many identifying terms as possible (limit is four words). You can search on just one word, but you may get more specific results when you enter two or three search terms. The search time may also be faster when you enter more than one word (e.g., ARM FRACTURE returns more specific results faster than searching on just ARM or FRACTURE).
- Avoid entering too many search terms or search terms that are too specific; in these instances there may be no results that exactly match your criteria.
- Avoid connecting words such as of, and, or, with, not, or punctuation such as commas, periods, dashes, etc.
- To go directly to a code/description in the Code Detail, enter a code number. If the number doesn’t exist (i.e., has been deleted or is otherwise invalid), the system displays the next valid code for CPT codes, and the next valid category for ICD-9-CM codes. For ICD-9-CM codes, you must enter a decimal for codes with additional digits.
- If doing a word search, do not enter numbers. For example, type “chest x-ray *two* views” instead of “chest x-ray 2 views.” Unless you are entering a code number, the search doesn’t recognize numbers.

- The Search recognizes several acronyms as search criteria. You can enter these terms just as they appear in your documentation. Encoder Pro automatically locates the correct code(s).

- For example, to locate CPT codes for Computerized Axial Tomography, you can enter the acronym “CAT.” To locate codes for arterial blood gases, you can type the acronym “ABG.”

**Determining Search Criteria**

When choosing search criteria from your documentation, it is important that you use terms that best identify the service or symptom. Entering the proper terms ensures that searching is quick and accurate. The suggestions below help you determine which terms to enter as search criteria.

**Criteria for CPT Codes**

To determine the criteria for a procedure code search, first ask yourself *what* was performed, and *where* (anatomical site) it was performed. Generally, the first two words of your documentation identify what and where; enter these terms as search criteria. For example, the key terms “arthroscopy shoulder” answers both what (arthroscopy) and where (shoulder). Entering these two terms brings up all codes containing arthroscopy and shoulder.

To further narrow the search, type one or two more terms that further explain the procedure. For example, entering “arthroscopy shoulder decompression” narrows the results to just one CPT Code, 29826, which contains all three terms. Avoid being too specific or entering too many search terms; in these instances, there may be no results that exactly match your criteria. It is best to choose two to four key search terms.

**Note:** Some terms explain both *what* was performed and *where*. For example, the term colonoscopy explains what was performed (scope) and where (colon).

**Criteria for ICD-9-CM Codes**

To identify the criteria for an ICD-9-CM Vol. 1 code search, ask yourself *why* the patient received care. From the documentation, pull up to four key terms that best describe the reason. For example, if a shoulder arthroscopy was performed, ask yourself why. Entering “joint tear” returns a large variety of matches in the Tabular Results. To return more specific results, include the specific *anatomical region*. Entering “joint tear shoulder” returns only the diagnosis codes that are specific to the shoulder.

To identify the criteria for an ICD-9-CM Vol. 3 code search, ask yourself *what* kind of procedure was performed (e.g., appendectomy, hysterectomy), and enter this term into the Search Prompt. To further define your search, include the *anatomical site* where the procedure was performed (e.g., abdominal region, pelvis).
Spell Checking Search Terms

When you enter a search term that is either incorrectly spelled or not found in the code databases, the Spell Check dialog box appears. Alternative search terms are listed for the search term you originally entered, and are based on the first letter of that term or a phonetic match.

To select an alternative search term:

1. Select the desired search term suggestion.
2. Click **Change**, which corrects your search term and closes the Spell Check dialog box. Doing this automatically continues your search based on the alternative term.
3. Click **Ignore** if you want to cancel out of this dialog box.
4. Start your search again.

**Note:** If you enter more than one search term, clicking **Change** accepts the alternative spelling and takes you to the next misspelled word (if any). Clicking **Ignore** on the first misspelled word still keeps you in the Spell Check dialog box if there is another misspelled or not found word in your original search.

Viewing Search Results

After you execute a search, the Tabular Results area of the main screen displays matches found in all applicable code sets.

The Tabular Results area also displays the **Total matches:** that let you know how many results match your search criteria, including the subsection range that the code(s) belong to for all CPT and HCPCS. The Total matches: area shows “0” if no results were found. The number changes when the results are filtered either through the **Narrow results by section** link or by changing your code set check boxes.
Viewing Additional Digit ICD-9-CM Codes

The Tabular Results box displays the code results. The parent grouping for ICD-9-CM codes is the 3-digit category (i.e., code number without decimal). ICD-9-CM codes with additional digits are consolidated into a common category. Codes that require additional digits have a plus sign \( + \) to the left of their folder.

Click the plus to expand the category and display subcodes.

<table>
<thead>
<tr>
<th>Plus sign</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>( + ) 080</td>
<td>Open wound of shoulder and upper arm</td>
</tr>
<tr>
<td>( + ) 887</td>
<td>Traumatic amputation of arm and hand (complex)</td>
</tr>
<tr>
<td>( + ) 711</td>
<td>Arthroplasty associated with infections</td>
</tr>
<tr>
<td>( + ) 84</td>
<td>Other procedures on musculoskeletal system</td>
</tr>
<tr>
<td>( + ) 912</td>
<td>Superficial injury of shoulder and upper arm</td>
</tr>
</tbody>
</table>

Click the minus sign to hide subcodes.

<table>
<thead>
<tr>
<th>Minus sign</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>( - ) 887</td>
<td>Traumatic amputation of arm and hand (complex)</td>
</tr>
<tr>
<td>( - ) 087</td>
<td>Traumatic amputation of arm and hand (c)</td>
</tr>
<tr>
<td>( - ) 851</td>
<td>Traumatic amputation of arm and hand (c)</td>
</tr>
<tr>
<td>( - ) 711</td>
<td>Arthroplasty associated with infections</td>
</tr>
<tr>
<td>( - ) 84</td>
<td>Other procedures on musculoskeletal system</td>
</tr>
</tbody>
</table>

Note: Only those subcodes that pertain to the search results are listed; not all third-, fourth- and/or fifth-digit codes are listed.
Viewing CPT and HCPCS Codes

CPT and HCPCS codes are consolidated into subsections identified by the range of codes in that subsection. For example, if CPT Code 21031 *Excision of torus mandibularis* is part of your results, it will be listed under this subsection range:

\[
21015-21070 \quad \text{Excision.}
\]

Each subsection range has a plus sign to the left.

Click the plus to expand the subsection listing and display codes.

Click the minus sign to hide codes.

Note: Only those codes that pertain to the search results are listed; not all codes in the subsection are listed.

Narrowing Search Results

Every time you perform a search, the Tabular Results box shows the matches found. Occasionally, you may enter a term that is too broad or too narrow. In either case, when you enter a search term that does not return tabular results, but does return index results, you’ll see a Results Alert dialog box. When it appears, clicking the Index Results button takes you directly to the Index Listing.

Results Alert

There are two ways to narrow your search as described below.
Specifying Code Sets

Specifying only the code types you are interested in assists you in focusing your search. You can “filter” the results displayed by selecting or clearing one or more check boxes. Each time the results are filtered (by selecting/deselecting a check box), the Total matches: area reflects the number of results.

1. Select the check box for each code set in which you want to view results—ICD-9 Vol. 1, ICD-9 Vol. 3, CPT, and/or HCPCS.

   For example, if you want to view just CPT code results, make sure that only the CPT check box is marked.

   A mark in the check box indicates a code set is selected. If a check box is dimmed, no results were found and the check box cannot be selected or cleared.

   The check boxes that are marked are based on the results found for your search.

   The code sets you are searching on are based on your preferences set in the Search Tab of the Preferences dialog box or through the Code Sets drop-down list on The Black Toolbar.

2. Refer to the Total matches: area to see how many results were found for the code set(s) selected. The number displayed there automatically updates when you select (or clear) the code set check box.

   Total matches: 130

Specifying Code Type

A method of refocusing your search is to click the Narrow results by section link. This allows you to select additional search criteria to narrow the focus of your search. This link is available only if the search results include codes that are in multiple sections of CPT, ICD-9-CM, or HCPCS.

Many search terms bring back results from multiple sections of ICD-9-CM Vol. 1, CPT, and/or HCPCS (e.g., the Tabular Results may list codes from the surgery, radiology, and medicine sections of CPT). If you have performed this type of search, the Specify Code Type dialog box appears when you click the Narrow results by section link. This dialog box allows you to narrow your search results by including (or excluding) code range sections that are appropriate.

Note: The Specify Code Type dialog box appears only for the code sets you select before initiating a search. For example, if you search on “biopsy” but only have the ICD-9 Vol. 1 check box marked when you click Narrow results by section link, you won’t see the range categories tab for CPT codes, even if CPT codes appeared in your initial tabular results. You must initiate the search again and make sure the CPT check box is marked when you click Narrow results by section link.
In the Specify Code Type dialog box, a tab appears for each code set (ICD-9 Vol. 1, CPT, and HCPCS) that has results listed for multiple code ranges. Depending on the search, this dialog box may display a tab for just one code set, two, or all three.

Use the Revert link to jump back to your original search results in the Tabular Results area.

**Note:** The Specify Code Type dialog box appears only for the code sets you select before initiating a search. For example, if you search on “biopsy” but only have the ICD-9 check box marked when you click Narrow results by section, you won’t see the range categories tab for CPT Codes, even if CPT Codes appeared in your initial tabular results. You must initiate the search again and make sure the CPT check box is marked when you click Narrow results by section.

In the Specify Code Type dialog box, a tab appears for each code set (ICD-9-CM Vol. 1, CPT, and HCPCS) that has results listed for multiple code ranges. Depending on the search, this dialog box may display a tab for just one code set, two, or all three. Here are all possible categories you may see when you click Narrow:

<table>
<thead>
<tr>
<th>ICD-9-CM</th>
<th>CPT</th>
<th>HCPCS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnosis</td>
<td>Anesthesia</td>
<td>A Codes – Transportation, Medical and Surgical Supplies</td>
</tr>
<tr>
<td>Health Status Factors (V Codes)</td>
<td>Surgery</td>
<td>B Codes – Enteral and Parenteral Therapy</td>
</tr>
<tr>
<td>External Causes (E Codes)</td>
<td>Radiology</td>
<td>C Codes – Outpatient PPS Temporary Codes</td>
</tr>
<tr>
<td>Pathology and Laboratory Medicine</td>
<td>Pathology and Laboratory Medicine</td>
<td>D Codes – Dental Procedures</td>
</tr>
<tr>
<td>Evaluation and Management</td>
<td>Evaluation and Management</td>
<td>E Codes – Durable Medical Equipment</td>
</tr>
<tr>
<td></td>
<td></td>
<td>G Codes – Procedures/ Professional Services</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Temporary)</td>
</tr>
</tbody>
</table>
ICD-9-CM | CPT | HCPCS
---|---|---
Category III | | H Codes – Alcohol and Drug Abuse Treatment Services
| | J Codes – Drugs Administered Other Than Oral Method, Chemotherapy Drugs
| | K Codes – Temporary
| | L Codes – Orthotic, Prosthetic Procedures
| | M Codes – Medical Services
| | P Codes – Pathology and Laboratory Services
| | Q Codes – Temporary
| | R Codes – Diagnostic Radiology
| | S Codes – Temporary National Codes (Non-Medicare)
| | T Codes – Codes Established for State Medicaid Agencies
| | V Codes – Vision, Hearing Services

Revert Button

After you use the Narrow results by section button to view a level of more specific results in the Specify Code Type dialog box, you can click the Revert button to go back to the previous (broader) level of search results. This button is not available when you first perform a search because the first listing of results is the broadest level.

Viewing Index Listing

You find codes from the ICD-9-CM, CPT, and HCPCS books by either searching the Code Detail or looking in the Index. Similar to the code books, you can use your Encoder Pro product to view codes for the current search as they are displayed in the Index, as well as view codes in the Code Detail.

To view the Index Listing:

1. Type search criteria in the Search box.
2. Click the Enter key or the Search button.

If the search criteria you enter is found in the Index, the See Index listing link is enabled. If no results in the Index match your search criteria, the See Index listing link remains disabled.
3. Click the **See Index listing** link to open the Index Listing dialog box.

   The Index Listing displays the applicable tab or tabs (depending on product and search preferences) for codes located in each applicable code set index: ICD-9 Vol. 2 (the index for ICD-9-CM Vol. 1 codes), ICD-9 Vol. 3, CPT, and HCPCS.

   - To view subcodes, click the plus box in front of a main code.
   - Click the minus box to hide subcodes.

**Note:** Because of the number of possible index matches for certain search terms, this dialog may take several seconds to open.

### Viewing Codes in the Code Detail

Select a code in the Index Listing window to view that code in the Code Detail. When you view a code in the Code Detail, the Index Listing remains open.


**Code Detail**

Viewing the selected code in the Code Detail is like looking up the code and description in the ICD-9-CM, CPT, or HCPCS code book.

---

**Code Detail**


- **84** Other procedures on musculoskeletal system
  - **84.0** Amputation of upper limb
    Excludes:
    - Amputation of amputation stump (84.3)
  - **84.08** Upper limb amputation, not otherwise specified
    - Closed flap amputation of upper limb NOS
    - Kneecap amputation of upper limb NOS
    - Open or guideline amputation of upper limb NOS
    - Revision of a current traumatic amputation of upper limb NOS
  - **84.01** Amputation and disarticulation of upper limb
    Excludes:
    - Iliac of supernumerary finger (85.25)
  - **84.02** Amputation and disarticulation of thumb
  - **84.03** Amputation through hand
  - Amputation through carpals
  - **84.04** Disarticulation of wrist
  - **84.05** Amputation through forearm
    - Forearm amputation
  - **84.06** Disarticulation of elbow
  - **84.07** Amputation through humerus
    - Upper arm amputation
  - **84.08** Disarticulation of shoulder
  - **84.09** Interthoracoscapular amputation

---

Once you’ve narrowed your search results sufficiently, select any code in the Tabular Results box to see it in the Code Detail panes. Code Detail displays which section of the appropriate book the code falls under, the description for the selected code and all neighboring codes, and any applicable color codes. Code Detail is presented in three panes:

**Section Headers.** This pane displays section titles that identify where in the ICD-9-CM, CPT, or HCPCS code book a group of codes are located. This pane defaults to the lowest level category in the book, but by using the drop-down list you see any of the higher levels as is applicable.

**Code Details.** This pane shows you the description for the selected code and all neighboring codes.

---

CPT only © 2005 American Medical Association. All rights reserved.
**Color Code Box.** This pane displays the color code symbols that are applicable to the selected code. Add-on Codes have blue hyperlinks to the Primary PX tab of the CPT Guidelines dialog, and take you there if you click on them. CPT and HCPCS codes that have Medicare policy references also have blue hyperlinks that take you to the corresponding dialog.

**Previous Section.** Clicking this link displays the Code Detail view for the previous section of codes.

**Next Section.** Clicking this link displays the Code Detail view for the next section of codes.

If a Sticky Note exists for codes selected in the Code Detail, a Sticky Note icon is also displayed in the Color Code box. For a quick view of the Sticky Note’s text, hold your mouse pointer over the Sticky Note icon and a help balloon appears with the Note’s contents. Otherwise, double-click on the Sticky Note icon to take you directly to the View Sticky Note dialog box.

### SELECTING A CODE FROM CODE DETAIL

When you select a code from the Code Detail, you can view the CPT Book guidelines, modifiers, unbundles, and cross-coding information through Code-Specific Dialog Boxes.

To select a code from the Code Detail:

1. Click any code to identify it as the selected code.
2. To scroll quickly to a code in the list, enter the code number at the search prompt.

### ICD-9-CM CODE DETAIL

The ICD-9-CM Code Detail arranges codes according to three-digit categories for Vol. 1 codes, and two-digit categories for Vol. 3 codes. You see the includes and excludes notes and government notes and instructions that affect all codes in each category. Codes that require additional digits are shown in red.

For example, the Code Detail for fourth-digit code 056.7 scrolls to the code within the three-digit category (056). You can view all applicable fifth-digit codes (056.71 and 056.79) and see all other fourth-digit codes in 056. You also see the Includes and Excludes notes that affect all codes in 056.

You can double-click any code that is cross-referenced in the Code Detail (such as codes in the Includes/Excludes notes) to identify it as the selected (highlighted) code. For example, if you click 771.0, which is referenced in the Excludes note for category 056, the Code Detail redisplayes, showing the codes and descriptions (with hierarchy) for 771.0.

ICD-9-CM color coding symbols provide further information for diagnosis codes (e.g., codes that require an additional digit, are nonspecific, are new, etc.). See ICD-9 Vol. 1 Color Coding Legend, and ICD-9 Vol. 1 Color Codes for additional information.
CPT AND HCPCS CODE DETAIL

For CPT and HCPCS codes, the Code Detail displays the code and full description for the selected code and a view of all other codes in the same section/subsection. CPT Codes that are shown as indented codes in the CPT code book are shown in the Code Detail with the full description instead. CPT and HCPCS codes in the Code Detail are grouped by section/subsection. The top pane of the Code Detail displays section titles that identify where in the CPT or HCPCS books a group of codes are located.

CPT color coding symbols shown in the bottom pane identify add-on (subsidiary) codes, codes for which Modifier -51 is exempt, new and revised codes, etc. Refer to CPT Color Coding Legend (not in CIFI9) for further information.

For HCPCS, color coding symbols shown in the bottom pane identify codes that aren’t covered by or valid for Medicare, have special coverage instructions, are reimbursed based on carrier discretion etc. Refer to HCPCS Color Coding Legend (not in CIFI9) for further information.
You can quickly view additional information from St. Anthony Publishing/Medicode’s top-selling publications for the selected code. You can open various dialog boxes for ICD-9-CM, CPT, and HCPCS codes selected from the Code Detail. This code-specific information is accessed from the buttons that appear at the top of your screen, and (depending on the product you have) from the ICD-9 Vol. 1, ICD-9 Vol. 3, CPT, or HCPCS menu. The name of the menu changes depending on the type of code selected in the Code Detail. The code-specific dialog boxes that are available are specific to the type of code selected. Refer to ICD-9-CM Vol. 1 Dialog Boxes, ICD-9-CM Vol. 3 Dialog Boxes, CPT Dialog Boxes, and HCPCS Dialog Boxes for the various dialog boxes you are able to access depending on the code selected.

The following paragraphs explain each code-specific dialog box. First, they show all dialog boxes available for ICD-9-CM codes, then dialog boxes for CPT Codes, and finally those available for HCPCS codes.

Notes: You must select a code in the Tabular Results to identify it as a selected code and display it in the Code Detail.  
If a dialog box is not available for the selected code, the corresponding button and menu option are dimmed to indicate that the information is not applicable to that particular code.

ICD-9-CM VOL. 1 DIALOG BOXES

ICD-9-CM Instructional Notes

This dialog box can be used to view notes from the code book that pertain to the selected code, and to view references to AHA Coding Clinic issues. You access this dialog box by selecting an ICD-9-CM code that has associated notes/references from the Code Detail. Then click either the Notes button from the toolbar, or go the ICD-9 Vol. 1 menu and select ICD-9-CM Instructional Notes.

Instructional Notes. This tab displays notes that apply to the selected code. These instructional notes, which appear at the beginning of certain sections in the Code Detail of ICD-9-CM, further define terms, clarify information, and provide fifth-digit information. They also contain includes and excludes notes that pertain to the selected code.
**References.** This tab displays references to issues of the American Hospital Association’s *Coding Clinic*, the official publication for the ICD-9-CM guidelines. It references *Coding Clinic* editions and page numbers in which the selected code has been discussed. The year is listed, then the range of months (for issues published before 1988) or the quarter, then the page number of the reference. For copies of the *Coding Clinic*, contact the AHA at (800) 261-6246.

**ICD-9-CM Annotations**

From this dialog box you can view annotations that pertain to the code selected. Annotations provide explanations of medical terminology and descriptions for specific diseases or conditions. You access this dialog box by selecting an ICD-9-CM code that has an annotation from the Code Detail. Then click either the **Annotations** button from the toolbar, or go the **ICD-9 Vol. 1** or the **ICD-9 Vol. 3** menu and select **Annotations**.
DRG Crosscodes (not in STND)

This dialog box provides you with corresponding Diagnostic Related Group (DRG) codes and Medicare reimbursement calculation information for ICD-9-CM codes. You can also view the DRGs that are crossed to the selected ICD-9-CM code. You access this dialog box by selecting an ICD-9-CM code in the Code Detail that has DRG crosscodes and then either clicking the **DRG** button or selecting **DRG Crosscodes** from the ICD-9 Vol. 1 or ICD-9 Vol. 1 menu.

**DRG Code and Description.** DRGs are groups of ICD-9-CM codes that report inpatient services to Medicare, Medicaid, and some private payers. DRGs standardize payment by illness and treatment, allowing reimbursement to be predicted prospectively, before care is provided. DRGs are defined as either medical or surgical.

**Major Diagnostic Category (MDC).** Each DRG falls into an MDC category. This classification of diagnoses, typically grouped by anatomic system, is the basis for the DRG prospective payment system.

**GMLOS, AMLOS, and RW.** The geometric mean length of stay (GMLOS), arithmetic length of stay (AMLOS), and relative weight (RW) are used for the Medicare reimbursement calculation for a particular DRG. The length of stay is averaged for the given DRG and GMLOS and is weighted to allow for outliers and other factors that skew data and potentially change reimbursement. The RW is a comparative, assigned weight to
indicate relative resource consumption associated with the given DRG. The higher the relative weight, the greater the reimbursement. The relative weight is multiplied by a facility’s conversion factor to produce the dollar amount to be paid the facility.

**Footnote.** The Footnote section contains information about the DRG code

### ICD-9 Vol. 1 Color Coding Legend

This information box displays a legend showing all ICD-9-CM Vol. 1 Color Codes and their definitions. You access it either by selecting an ICD-9-CM code, and then clicking the **Color Coding Legend** button from the toolbar, or by selecting **Color Coding Legend** from the ICD-9 Vol. 1 menu.

The following explains each ICD-9-CM Vol. 1 color coding symbol.

**Fourth Digit Code Required** - This symbol identifies codes that require an additional fourth digit be added to the ICD-9-CM Vol. 1 code. Either the code category or subcategory contains more specific codes, or the code choices are listed with the main category.

**Fifth Digit Code Required** - This symbol identifies codes that require an additional fifth digit be added to the ICD-9-CM Vol. 1 code. Either the code category or subcategory contains more specific codes, or the code choices are listed with the main category.

**New Code** - This symbol identifies ICD-9-CM Vol. 1 codes that are new.

**Revised Code** - This symbol identifies ICD-9-CM Vol. 1 codes that have been revised.

**Male Diagnosis** - This symbol identifies ICD-9-CM Vol. 1 codes that are considered a male diagnosis.
Female Diagnosis - 🌸
This symbol identifies ICD-9-CM Vol. 1 codes that are considered a female diagnosis.

Adult Diagnosis - 🠉
This symbol identifies ICD-9-CM Vol. 1 codes that are considered an adult diagnosis.

Maternity Diagnosis - 🏫
This symbol identifies ICD-9-CM Vol. 1 codes that are associated with maternity.

Newborn Diagnosis - 🍼
This symbol identifies ICD-9-CM Vol. 1 codes that are considered a newborn diagnosis.

Pediatric Diagnosis - 🧪
This symbol identifies ICD-9-CM Vol. 1 codes that are considered a pediatric diagnosis.

Unspecified Code - 🌟
This symbol indicates that a code is classified as “unspecified,” “other,” or “ill-defined.” Codes identified by this symbol are also known as “dump” codes or “catch-all” codes. An “unspecified” code can be a valid choice if it most closely describes your diagnosis, but use these codes only after checking all other options.

Other Specified Code - 📔
This symbol indicates a specified diagnosis, but the ICD-9-CM system does not have a specific code that describes the diagnosis. These codes may be stated as "Other" or "Not elsewhere classified (NEC).

Manifestation Code - Not a Primary Diagnosis - 🗒
This symbol identifies ICD-9-CM Vol. 1 codes that do not report primary diagnoses. Also known as “manifestations,” these codes should only be listed as secondary diagnoses where appropriate. Simply stated, these codes are never used alone.

Medicare Secondary Payer Primary Diagnosis - 🙅‍♀️
This symbol identifies ICD-9-CM Vol. 1 codes that are Medicare Secondary Payer codes and not a Primary Diagnosis.

Duplicate Primary Diagnosis - 🚡
This symbol identifies ICD-9-CM Vol. 1 codes that are duplicate Primary Diagnoses.

V Code as a Primary Diagnosis - 🚹
This symbol identifies ICD-9-CM Vol. 1 V Codes that are considered a Primary Diagnosis.

V Code as a Secondary Diagnosis - 🚻
This symbol identifies ICD-9-CM Vol. 1 V Codes that are considered a Secondary Diagnosis.

Comorbidity or Complication - 🚫
This symbol identifies ICD-9-CM Vol. 1 codes that are related to comorbidity or a complication.

Sticky Notes - 📄
This symbol identifies codes with attached sticky notes. See page 72 for details on using sticky notes.
ICD-9-CM Vol. 3 Dialog Boxes

ICD-9-CM Annotations

Please refer to page 42 for details.

ICD-9 Vol. 3 Crosscodes (EXPT and PRO only)

This dialog box displays CPT surgical codes that correspond to the selected ICD-9-CM Vol. 3 surgery code. Select an ICD-9-CM Vol. 3 code in the Code Detail that has CPT crosscodes and click the Crosscodes button on the toolbar or select Crosscoder from the ICD-9 Vol. 3 menu to open the dialog box.

This dialog box contains code number links to go to the appropriate code in the Code Detail. Double-click on the link or select it and click the Select button. The Crosscodes dialog box closes and the selected code and its description appears in the Code Detail.

DRG Crosscodes (not in STND)

Please refer to page 43 for details.
ICD-9 Vol. 3 Color Coding Legend

This information box displays a legend showing all ICD-9-CM Vol. 3 Color Codes and their definitions. You access it first by selecting a ICD-9-CM Vol. 3 code and then click the Color Coding Legend button from the toolbar, or select Color Coding Legend from the ICD-9-CM Vol. 3 menu.

The following explains each ICD-9-CM Vol. 3 color coding symbol.

- **Third Digit Code Required** - This symbol identifies codes that require an additional third digit be added to the ICD-9-CM Vol. 3 code. Either the code category or subcategory contains more specific codes, or the code choices are listed with the main category.

- **Fourth Digit Code Required** - This symbol identifies codes that require an additional third digit be added to the ICD-9-CM Vol. 3 code. Either the code category or subcategory contains more specific codes, or the code choices are listed with the main category.

- **New Code** - This symbol identifies ICD-9-CM Vol. 3 codes that are new.

- **Revised Code** - This symbol identifies ICD-9-CM Vol. 3 codes that have been revised.

- **Male Diagnosis** - This symbol identifies ICD-9-CM Vol. 3 codes that are considered a male diagnosis.

- **Female Diagnosis** - This symbol identifies ICD-9-CM Vol. 3 codes that are considered a female diagnosis.

- **Non-OR Procedure Affecting DRGs** - This symbol identifies ICD-9-CM Vol. 3 codes that are not operating room (OR) procedures (as determined by the DRG grouper) but do affect DRG assignment.

- **Valid OR Procedure** - This symbol identifies ICD-9-CM Vol. 3 codes that are valid operating room (OR) procedures (as determined by the DRG grouper) that may affect DRG assignment.
Non-Specific OR Procedure - This symbol indicates that a code is classified as “unspecified,” “other,” or “ill-defined” operating room procedure.

Noncovered Procedure - This symbol identifies a procedure that is not covered by Medicare.

Limited coverage - This symbol identifies a procedure that has limited coverage by Medicare.

Bilateral Procedure - This symbol identifies a procedure that is bilateral.

Sticky Notes - This symbol identifies codes with attached sticky notes. See page 72 for details on using sticky notes.

CPT DIALOG BOXES

CPT Section Notes (not in CIFI9)

This dialog box allows you to view CPT guidelines that depending on the code you select, provide parenthetical commentary (instructions), references to AMA CPT Assistant issues, primary procedure codes that are appropriate for use with CPT add-on codes, and examples for CPT Evaluation & Management Codes. The CPT Section Notes dialog box contains five possible tabs: Section Notes, Instructions, References, Primary Px, and Examples. You only see the tabs applicable to the code you selected. You open this dialog box by selecting a CPT Code that has associated notes/references/examples from the Code Detail. Then click either the Notes button from the toolbar, or go the CPT menu and select CPT Section Notes.

Section Notes. This tab displays information that appears at the beginning of sections or subsections in CPT for the selected code.

Instructions. This tab displays CPT parenthetical commentary for the selected code.
**References.** This tab displays references to issues of the American Medical Association’s *CPT Assistant*, the official publication for the AMA guidelines. It references *CPT Assistant* editions and page numbers in which the selected code has been discussed. The year is listed, then the quarter, then the page number of the reference. For copies of the *CPT Assistant*, contact the AMA at (800) 621-8335.

**Primary Px.** This list shows the primary procedure code(s) appropriate for use with the selected add-on code. The tab contains magenta code number links that direct you to the appropriate code in the Code Detail. You can access the links by double-clicking or by selecting them and then clicking the **Select** button.

**Examples.** This tab is visible only for E/M codes. It shows clinical examples from Appendix D of the *CPT Book*. As described in *CPT*, clinical examples of the CPT codes for E/M services are intended to be an important element of the coding system. The clinical examples, when used with the E/M descriptors contained in the full text of the *CPT Book*, provide a comprehensive and powerful new tool for physicians to
report the services provided to their patients.

The clinical examples that are provided are limited to Office or Other Outpatient Services, Hospital Inpatient Services, Consultations, Critical Care, Prolonged Services, and Care Plan Oversight.

These examples do not encompass the entire scope of medical practice. Inclusion or exclusion of any particular specialty group does not infer any judgment of importance or lack thereof; nor does it limit the applicability of the example to any particular specialty.

It is important to note that these are only examples. A particular patient encounter, depending on the specific circumstances, must be judged by the services provided by the physician for that particular patient. Simply because the patient’s complaints, symptoms, or diagnoses match those of a particular clinical example, does not automatically assign that patient encounter to that particular level of service. The three key components (history, examination, and medical decision making) must be met and documented in the medical record to report a particular level of service.

**CPT Lay Descriptions (not in CIFI9)**

From this dialog box you can view lay (nonclinical) descriptions for most CPT surgery and medicine codes. You open this dialog box by selecting a CPT code that has lay descriptions from the Code Detail. Then click either the **Annotations** button from the toolbar, or go the CPT menu and select **Lay Descriptions**.
CPT Modifiers (not in CIF9)

This dialog box displays a list of CPT modifiers and descriptions that are appropriate for the selected code. You can sort by either column. Select a CPT Code in the Code Detail that has a modifier and click the **Modifiers** button on the toolbar or select **Modifiers** from the CPT menu to open the **CPT Modifiers** dialog box.

CPT Crosscoder (EXPT and PRO only)

This dialog box displays applicable ICD-9-CM diagnosis (Vol. 1), ICD-9-CM procedure codes (Vol. 3), HCPCS codes, Dental codes, CPT anesthesia codes, medicine codes, radiology codes and lab codes that are crossed to the selected CPT code. Tabs are displayed that contain the applicable code sets.

Click the **Crosscoder** button on the toolbar or select **Crosscoder** from the CPT menu.

This dialog box contains code number links that go to the appropriate code in the Code Detail. Double-click on the link or select it and click the **Select** button. The Crosscodes dialog box closes and the selected code and its description appears in the Code Detail.

CPT CCI Unbundle Edits (EXPT and PRO only)
This dialog box allows you to see Medicare’s Correct Coding Initiative unbundle edits for the selected CPT code. It shows CPT codes that should not be billed with the selected CPT code. The reason for the unbundle edit, as defined by the Medicare Correct Coding Initiative, is also shown. You open this dialog box by selecting a CPT code in the Code Detail that has CCI unbundle edits and then either clicking the **CCI Edits** button from the toolbar, or selecting **CCI Unbundle Edits** from the CPT menu.

The **Code** column in all three tabs contains magenta code number links that take you to the appropriate code in the Code Detail. These codes represent codes that you cannot bundle with the original CPT code you selected in the Code Detail. You can access the links by double-clicking them or by selecting them and then clicking the **Select** button.

The **Reason** column provides you the reason this edit is not allowed.

The **Modifier** column indicates whether the use of a modifier is allowed in order to differentiate between the services provided. If allowed, an appropriate modifier must be used with the code that represents a component procedure and/or the code that represents the greater procedure, as is appropriate. The meaning attached to the modifier adds specificity about the services being billed which helps to differentiate between the services represented by the different codes. Assuming the modifier is used correctly and appropriately, this specificity provides the basis upon which separate payment for the services billed may be considered justifiable. Generally, the modifiers which are most likely to add specific or further information to the billed codes are: E1-E4, FA, F1-F9, TA, T1-T9, LT, RT, LC, LD, RC, 58, 59, 78 and 79.

**Tabs**

At least one of the following three tabs are also included in this dialog box depending on the code selected:

**CCI Component tab.** If the selected CPT code represents a comprehensive procedure, these unbundles list the CPT codes that represent the components of the comprehensive procedure.
CCI Mutually Exclusive tab. Codes listed here represent those procedures that cannot be performed during the same operative session.

CCI Greater Px tab. This tab shows the greater procedure (or comprehensive) codes of which a component code could be considered an edit. It allows you to see the complete CCI relationships, regardless of what code is selected.

CCI Data

CPT codes Copyright© 2005 American Medical Association. All Rights Reserved.

The Centers for Medicare and Medicaid Services (CMS), formerly the Health Care Financing Administration, is responsible for the content of CCI data. No endorsement by the American Medical Association (AMA) is intended or should be implied. The AMA disclaims responsibility for any consequences or liability attributable to or related to any uses, non-use, or interpretation of information contained or not contained in this product. The Correct Coding Policies do not supersede any other specific Medicare coding, coverage, or payment policies.

The Physicians’ Current Procedural Terminology developed by the American Medical Association and HCPCS Level II codes developed by the Centers for Medicare and Medicaid Services (CMS) are listings of descriptive terms and identifying codes for reporting medical services and procedures performed by physicians. The codes in the CPT Manual are copyrighted by the AMA, and updated annually by the CPT Editorial Panel based on input from the AMA Advisory Committee which serves as a channel for requests from various providers and specialty societies. The purpose of both coding systems and annual updates is to communicate specific services rendered by physicians.
and other providers, usually for the purpose of claim submission to third party (insurance) carriers. A multitude of codes is necessary because of the wide spectrum of services provided by various medical care providers. Because many medical services can be rendered by different methods and combinations of various procedures, multiple codes describing similar services are frequently necessary to accurately reflect what service a physician performs. While often only one procedure is performed at a patient encounter, multiple procedures are performed at the same session at other times. In the latter case, the pre-procedure and post-procedure work does not have to be repeated and, therefore, a comprehensive code, describing the multiple services commonly performed together, can be defined.

Third party payers have adopted the CPT coding system for use by providers to communicate payable services. It therefore becomes more important to identify the various potential combinations of services to accurately adjudicate claims.

**LMRP Medical Necessity Edits (EXPT and PRO only)**

This dialog box allows you to see which ICD-9-CM codes are allowable for a selected CPT code and Medicare carrier. You access this dialog box by selecting a CPT or HCPCS code in the Code Detail and clicking the LMRP Edit button or by selecting Local Medical Review Policies from the CPT or HCPCS menu. The button and menu are only active if there are LMRP edits for the selected code and carrier preference code.

The Local Medical/Medicare Review Policy is an administrative and educational tool to assist providers, physicians, and suppliers in submitting correct claims for payment. Local policies outline how contractors review claims to ensure that they meet Medicare coverage requirements.

Under the Medicare program, the government pays only for “medically necessary” services. The Medicare carriers and intermediaries have significant authority, through their medical directors, to define what is “medically necessary.” LMRPs can include incorrect or incomplete information as they are relative to a specific region, carrier, or procedure and can vary widely.

Encoder Pro Expert and Professional review procedure and diagnosis codes against edits for active Part B LMRPs for all carriers and regions to ensure that providers billing Medicare can receive proper reimbursement. These LMRP edits are designed to give information as to which diagnoses are considered “medically necessary” and are covered by Medicare. If a relationship exists to support medical necessity, then there is no LMRP Edit Conflict. If a relationship does not exist in the LMRP data for a certain CPT-ICD combination then there is an LMRP Edit Conflict. This conflict is shown as an alert and it could be due to several different reasons.

At times a Medicare carrier does not list a particular diagnosis with a procedure code that it may match clinically (and meet valid cross-coding requirements). This may be due to the fact that they require submission of a different diagnosis for the procedure to be covered. They may not accept a diagnosis just because it may clinically seem valid for the procedure. EXPT and PRO alert providers to this type of conflict and others and asks the provider to rely on their history of billing and reimbursement with their carrier to override any potential LMRP Edit Conflicts if they choose to do so.

In the event that you need access to newly published LMRP or want further clarification, please see [http://www.lmrp.net](http://www.lmrp.net).
The drop-down list shows the Medicare Carrier you selected from the Edit menu’s Select Carrier / Locality option (see page 83 for information on selecting your Medicare Carrier Locality). However, you can use the drop-down list to view the LMRP data for any Medicare locality.

The Make default Medicare Carrier/Locality check box can be checked if you want to make the locality you are currently viewing the default carrier.

A Find box allows you to search for ICD-9-CM codes that are allowable for a selected CPT or HCPCS code.

The code list box shows all of the ICD-9-CM codes that are Medical Necessity edits for the selected CPT code and Medicare Carrier. It contains magenta code number links that take you to the appropriate code in the Code Detail. You can access the links by double-clicking or by selecting them and then clicking the Select button.

Local Medical/Medicare Review Policy (LMRP)

LMRP is an administrative and educational tool to assist providers, physicians, and suppliers in submitting correct claims for payment. Local policies outline how contractors review claims to ensure that they meet Medicare coverage requirements. CMS requires that local policies be consistent with national guidance (although they can be more detailed or specific), and be developed with scientific evidence and clinical practice.
Under the Medicare program, the government pays only for “medically necessary” services. The Medicare carriers and intermediaries have significant authority, through their medical directors, to define what is “medically necessary.” LMRPs can include incorrect or incomplete information as they are relative to a specific region, carrier, or procedure, and can vary widely.

The Medicare program requires that a proposed LMRP be published for comment before it is instituted. Proposed LMRPs are published by carrier and intermediary in infrequent bulletins. Sometimes proposed LMRPs are flawed and need revision. Often, providers get stuck with an LMRP that may inappropriately restrict Medicare coverage for services due to their very unrefined nature.

LMRPs become effective 30 days from the date of publication. The following general Medicare guidelines apply to all published LMRPs:

**Medically Necessary and Reasonable**

Title XVIII of the Social Security Act, Section 1862 (a)(1)(A) states "...no payment may be made under Part A or Part B for any expenses incurred for items or services which are not reasonable and necessary for the diagnosis or treatment of illness or injury or to improve the functioning of a malformed body member."

Medicare limits coverage of many procedures to certain ICD-9-CM diagnosis codes. Please be aware that it is not enough to link the procedure code to a payable ICD-9-CM diagnosis code. The diagnosis must be present for the procedure to be paid, but in addition, the procedure must be medically reasonable and necessary and representative of the patient’s condition. Medicare may require documentation of medical necessity on a pre-payment and/or post-payment basis or comprehensive medical review basis.

Please note that the ICD-9-CM codes must be coded to the highest level of specificity, coding to the fourth or fifth digit. This is a requirement for all claims.

**Documentation**

Documentation supporting the medical necessity of the service should be legible, maintained in the patient’s medical record, and must be made available to Medicare upon request.

**Reimbursement**

All of the coverage criteria listed for an individual Local Medical Review Policy must be met.

**National Policy**

In the event that a national policy is established for any of these local medical policies, the national policy takes precedence over the local policy.

**Focused Medical Review**

Medicare continues to monitor the utilization of Local Medical Policies through the Focused Medical Review (FMR) process.
National Coverage Determinations Edits (EXPT and PRO only)

This dialog box allows you to see which ICD-9-CM codes are allowable for a selected CPT code. You access this dialog box by selecting a CPT or HCPCS code in the Code Detail and clicking the NCD Edit button or by selecting National Coverage Determinations from the CPT or HCPCS menu. The button and menu are only active if there are NCD edits for the selected code. An NCD for a diagnostic laboratory test is a national policy statement granting, limiting or excluding Medicare coverage for that test. It states CMS’s policy with respect to the circumstances under which the test(s) are considered reasonable and necessary, and not screening or otherwise not covered, for Medicare purposes. Such a policy applies nationwide. An NCD is neither a practice parameter nor a statement of the accepted standards of medical practice.

Words such as “may be indicated” or “may be considered medically necessary” are used for this reason. Where a policy gives a general description and then lists examples, the list of examples is not meant to be all inclusive, but merely to provide guidance.

The Local Medical/Medicare Review Policy is an administrative and educational tool to assist providers, physicians, and suppliers in submitting correct claims for payment. Local policies outline how contractors review claims to ensure that they meet Medicare coverage requirements.

Encoder Pro Expert and Professional review procedure and diagnosis codes against edits for active Part B LMRPs for all carriers and regions to ensure that providers billing Medicare can receive proper reimbursement.

A Find box allows you to search for ICD-9-CM codes that are allowable for a selected CPT or HCPCS code.

The code list box shows all of the ICD-9-CM codes that are Medical Necessity edits for the selected CPT code and Medicare. It contains magenta code number links that take you to the appropriate code in the Code Detail. You can access the links by double-clicking or by selecting them and then clicking the Select button.

Medically Necessary and Reasonable

Title XVIII of the Social Security Act, Section 1862 (a)(1)(A) states "...no payment may be made under Part A or Part B for any expenses incurred for items or services which are not reasonable and necessary for the diagnosis or treatment of illness or
injury or to improve the functioning of a malformed body member."

Medicare limits coverage of many procedures to certain ICD-9-CM diagnosis codes. Please be aware that it is not enough to link the procedure code to a payable ICD-9-CM diagnosis code. The diagnosis must be present for the procedure to be paid, but in addition, the procedure must be medically reasonable and necessary and representative of the patient’s condition. Medicare may require documentation of medical necessity on a pre-payment and/or post-payment basis or comprehensive medical review basis.

Please note that the ICD-9-CM codes must be coded to the highest level of specificity, coding to the fourth or fifth digit. This is a requirement for all claims.

**Documentation**

Documentation supporting the medical necessity of the service should be legible, maintained in the patient’s medical record, and must be made available to Medicare upon request.

**Reimbursement**

All of the coverage criteria listed for National Coverage Determinations must be met.

**National Policy**

In the event that a national policy is established for any of the local medical policies, the national policy takes precedence over the local policy.

**Medicare Physician Fee Schedule (EXPT and PRO only)**

This dialog box allows you to view information for CPT codes from the Medicare Physician Fee Schedule. When applicable, this dialog box provides you with actual payment information such as Relative Value Units, Global Information, and specific Medicare Rules from the Medicare Physician Fee Schedule.

You access this dialog box by selecting a CPT code from the Code Detail and then clicking either the CMS Fee button or selecting Medicare Fee Schedule from the CPT menu.

**RVUs - Facility.** This tab shows relative value units (RVUs) for procedures performed in a hospital, skilled nursing facility, or an ambulatory surgery center.

The RVUs are broken out into the components of physician work (Work RVU), practice expense (PE RVU), and malpractice relative value units. The total RVU is also supplied. The 2003 conversion factor, 36.7856, is displayed at the bottom of the dialog box.
**RVUs - Nonfacility.** This tab shows relative value units (RVUs) for procedures performed in a physician’s office, patient’s home, or any other facility or institution, such as a residential care setting, that is not a hospital, SNF or ASC.

The RVUs are broken out into the components of physician work (Work RVU), practice expense (PE RVU) and malpractice relative value units. The total RVU is also supplied. The 2003 conversion factor, 36.7856, is displayed at the bottom of the dialog box.

**Global Information.** This tab shows global period information for the selected CPT code. The global period is the time following surgery during which routine care by the physician is considered postoperative and included in the surgical fee. Office visits or other routine care related to the original surgery cannot be separately reported if they occur during the global period. Global periods are sometimes referred to as “follow-up days” or FUDs.
The Global Split section shows a breakdown of how Medicare expects the value of an encounter to be split if different components of the encounter are performed by different physicians.

You see the percentages that would be paid to physicians for preoperative, intraoperative, and postoperative services, if these services were performed separately.

**Medicare Rules.** This tab lists the Medicare edits that are applicable to the selected CPT code. Each rule is listed and explained in detail in the online Help.
Medicare Fee (EXPT only). This tab provides you with area-specific payment information.

The Payment Information field allows you to select a Medicare locality from a drop-down menu. You may also choose to make a default locality from the check box.

The Total Payment Calculation area displays the calculated Medicare payment information for the selected Medicare carrier / locality. Calculated fees are shown for Facility and Non-facility. Where modifiers apply, fees are shown for Global values, Modifier -26 (Professional Component), and Modifier -TC (Technical Component).

Special Coverage Instructions (not in CIF9)

The Special Coverage Instructions dialog box (CPT or HCPCS) provides important information about Medicare payment policies for either CPT or HCPCS codes depending on the type of code selected. Select a HCPCS or CPT code from the Code Detail and click the CMS button or select Medicare Policy from the HCPCS or CPT menu. Click this button to displays special coverage instructions for the selected CPT or HCPCS code from these applicable Medicare References: Pub 100.
CPT Color Coding Legend (not in CIFI9)

This dialog box displays a legend showing all CPT Color Codes and their definitions. You access it either by clicking the **Color Coding Legend** button from the toolbar, or by selecting **Color Coding Legend** from the CPT menu.

The following explains each CPT color coding symbol.

- **New Code** - This symbol indicates new CPT codes.
- **Revised Code** - This symbol indicates CPT codes with revisions; codes with minor terminology changes are not identified.
- **Age Restrictions** - This symbol identifies a CPT code that has age restrictions, as identified by Ingenix clinicians.
- **Maternity** - This symbol identifies procedures that by definition should only be used for maternity patients generally between 12 and 55 years of age.
- **Male Procedure** - This symbol identifies CPT codes that are considered a male diagnosis, as identified by Ingenix clinicians.
- **Female Procedure** - This symbol identifies CPT codes that are considered a female diagnosis, as identified by Ingenix clinicians.
- **Modifier -51 Exempt** - This symbol indicates codes for which modifier -51 is exempt.
- **Nonspecific Code** - This symbol indicates nonspecific CPT codes (i.e., unlisted codes).
- **Add-on code-AMA** - This symbol indicates add-on (subsidiary) codes as identified by the American Medical Association in the *CPT Book*. The principal procedure code(s) that the add-on code is supplemental to are listed after the code description in the Code Detail.
- **Add-on code-Ingenix** - This symbol indicates additional add-on codes as identified by Ingenix clinicians. The principal procedure code(s) that the code is supplemental to are listed after the code description in the Code Detail.
- **Commonly Miscoded Procedure** - This symbol identifies CPT codes that are commonly miscoded, as identified by Ingenix clinicians.
**Medicare Policy - CMS**
This symbol identifies services that have special Medicare coverage policies and/or rules.

**Modifier -63 Exempt-**
This symbol indicates codes for which modifier -63 is exempt.

**Conscious Sedation-**
This symbol identifies conscious sedation services.

**Sticky Notes -**
This symbol identifies codes with attached sticky notes. See page 72 for details on using sticky notes.

---

**HCPCS DIALOG BOXES**

**HCPCS Section Notes (not in CIFI9)**
This dialog box allows you to view notes in the code book that pertain to the code selected. These notes appear at the beginning of certain sections in the HCPCS book. HCPCS section notes include ambulance origin modifiers, destination modifiers, and PET scan modifiers. You access this dialog box by selecting a HCPCS code that has associated notes from the Code Detail. Then click either the **Notes** button from the toolbar, or go to the HCPCS menu and select **HCPCS Section Notes**.

![HCPCS Section Notes](image)

**HCPCS Annotations (not in CIFI9)**
From this dialog box you can view annotations from Ingenix’s HCPCS Level II Expert that pertain to the code selected. Annotations provide more information about medical and surgical supplies, durable medical equipment, drugs, and certain professional services. You access this dialog box by selecting a HCPCS code that has an annotation from the Code Detail. Then click either the **Annotations** button from the toolbar, or go to the HCPCS menu and select **Annotations**.

---

*CPT ONLY © 2005 AMERICAN MEDICAL ASSOCIATION. ALL RIGHTS RESERVED.*
Covered only in conjunction with electocardiographic stress testing in male patients with atypical angina or nonspecific chest pain, or female patients with angina.
HCPCS Modifiers (EXPT and PRO only)

This dialog box shows you a list of HCPCS modifiers (with their descriptions) that are appropriate for the selected code. Modifiers that include ambulance origin, destination modifiers, and PET scan modifiers are listed in the HCPCS Section Notes. You can sort by either column. This dialog box is opened when you select a HCPCS code in the Code Detail that has a modifier and click the Modifiers button from the toolbar, or when you select Modifiers from the HCPCS menu.

HCPCS Crosscodes (EXPT and PRO only)

This dialog box displays applicable ICD-9-CM diagnosis (Vol. 1), ICD-9-CM procedure codes (Vol. 3) and CPT codes that are crossed to the selected HCPCS code. Tabs are displayed that contain the applicable code sets.

Select a HCPCS code in the Code Detail that has crosscodes and click the Crosscoder button on the toolbar or select Crosscoder from the HCPCS menu.

This dialog box contains code number links that go to the appropriate code in the Code Detail. Double-click the link or select it and click the Select button.
HCPCS CCI Unbundle Edits (EXPT and PRO only)

This dialog box allows you to see HCPCS codes that have unbundle edits based on Medicare’s Correct Coding Initiative (CCI). It shows CPT codes that should not be billed with the selected HCPCS code. The reason for the unbundle edit, as defined by the Medicare Correct Coding Initiative, is also shown. You open this dialog box by selecting a HCPCS code in the Code Detail that has CCI unbundle edits and then either clicking the CCI Edits button from the toolbar, or selecting CCI Unbundle Edits from the HCPCS menu.

This dialog box contains magenta code number links that take you to the appropriate code in the Code Detail. You can access the links by double-clicking them or by selecting them and then clicking the Select button.

Tabs

At least one of the following three tabs are also included in this dialog box depending on the code selected:

CCI Component tab. If the selected HCPCS code represents a comprehensive procedure, these unbundles list the HCPCS codes that represent the components of the comprehensive procedure.

CCI Greater Px tab. This tab shows the greater procedure (or comprehensive) codes of which a component code could be considered an edit. It allows you to see the complete CCI relationships, regardless of what code is selected.
CCI Mutually Exclusive tab. These unbundles are part of Medicare’s Correct Coding Initiative edit. Codes listed here represent those procedures that cannot be performed during the same operative session.

HCPCS Color Coding Legend (not in CIFI9)

This information box displays a legend showing all HCPCS Color Codes and their definitions. Color coding symbols identify special Medicare coverage issues affecting HCPCS codes. You access this information box first by clicking a HCPCS code in the Code Detail and then click the Color Coding Legend button from the toolbar, or select Color Coding Legend from the HCPCS menu.
The following explains each HCPCS color coding symbol.

- **New Code** - This symbol identifies new HCPCS codes.
- **Revised Code** - This symbol identifies revised HCPCS codes.
- **Carrier Discretion** - This symbol identifies codes that require carrier discretion. Contact your carrier for specific coverage information for these codes.
- **Not Covered By or Valid for Medicare** - This symbol identifies codes that are not covered by or valid for Medicare. Click the Medicare Information button to read pertinent CIM and MCM references.
- **Quantity Alert** - This symbol identifies codes that have an amount associated with them.
- **Medicare Policy** - This symbol identifies services that have special Medicare coverage policies and/or rules.
- **Sticky Notes** - This symbol identifies codes with attached sticky notes. See page 72 for details on using sticky notes.
User Tools

Using Bookmarks

The Bookmarks dialog box displays a ready-reference list of “bookmarks” for codes that you regularly use. These place markers are a convenient way to go directly to the Code Detail for a selected code. The title of the dialog box changes to Network Bookmarks if you have a multiple-user version of the program.

To open the Bookmarks dialog box, click the Bookmarks button or select Bookmarks from the View menu.

This dialog box contains code number links that direct you to the appropriate code in the Code Detail. The program also provides you with a description of the code, and the category you selected when you created it. You can access the code you bookmarked by selecting it and then clicking the Go to Bookmark button. You can also double-click the code you bookmarked to take you directly to that code in the Code Detail.

The default is for all bookmarks to appear when you first see the Bookmarks dialog box. If you want to narrow your view to only certain types of codes, go to the View Only check boxes and uncheck the code set(s) you aren’t interested in viewing (ICD-9-CM Vol. 1, ICD-9-CM Vol. 3, CPT, or HCPCS).

Multiple-User Version Note: If you have the multiple-user version of this program, the Bookmarks dialog box contains a Global tab. Click this tab to view global bookmarks added by the System Administrator. To add, edit, or delete a global bookmark you must login as the System Administrator. Refer to System Administrator Login for instructions.

Updating Bookmarks

The Bookmarks dialog box doesn’t contain any codes or sticky notes when you first install this program. You must add all bookmarks codes to the dialog box. If you are installing over a previous version, all bookmarks are preserved. However, if you in a previous version had a bookmark assigned to a code that the AMA has decided to delete, you receive this warning dialog box when you first open the Bookmarks dialog box:

Take the appropriate actions according to your needs.
Adding a New Bookmark

You can add as many codes to the bookmark list as you want. To add a bookmark:

1. From the Code Detail, select the code that you want to add to the bookmarks list.

2. Open the Add Code dialog box by clicking the Add button from the toolbar or selecting Add from the Edit menu.

   The Add Code dialog box lists the code and description of the selected code. You choose to add the code to your personal bookmarks list, personal sticky notes, or notepad. If you are logged on as a System Administrator, you may also choose to add the code to Global bookmarks.

3. Select the Bookmarks Personal or Global check box to specify you are adding a bookmark.

4. Click OK. The (Personal or Global) Bookmark dialog box appears.

5. Assign your bookmark a category (not required) and modify the code’s description if you’d like.

6. Click OK.

Shortcut

To quickly add a code to Bookmarks opening the Add Code dialog box:

1. Right-click the desired code in the Code Detail. The Add Code shortcut menu appears.

2. Select Add to Personal (or Global) Bookmarks. The (Personal or Global) Bookmark dialog box appears.

3. Assign your bookmark a category (not required) and modify the code’s description if you’d like.

4. Click OK.

Editing a Bookmark
You can change the description of your bookmark or change the category by clicking the **Edit** button from the Bookmarks dialog box. You also have this opportunity whenever you add a bookmark to a code with either the Add Code dialog box or the Right-click Add menu (unless you have deselected this action from the View Tab in the Preferences dialog box).

![Bookmarks dialog box](image)

From the resulting (Personal or Global) Bookmark dialog box you can create and assign categories to your bookmarks. In the **Category** field, you can enter up to 35 characters to denote a category name. If there are already user-defined categories entered, this field displays them as a drop-down menu if they match what you are typing. You can enter an unlimited number of categories, and can delete a category by highlighting the category and using the **Delete** key. Any bookmarks assigned that category name are assigned to no category (blank category). Global and personal bookmark categories are unique. You must add your categories to both types of bookmarks if you are using both.

To edit a bookmark description or to add or edit its category:

1. Select the personal or global bookmark you want to edit from within the Bookmarks dialog box.
2. Click the **Edit** button. The (Personal or Global) Bookmark dialog box appears.
3. When you finish making changes to the description or category, click **OK**.

**Deleting a Bookmark**

To delete a code from the bookmark list:

1. Open the Bookmarks dialog box by clicking the **Bookmarks** button or selecting **Bookmarks** from the View menu.
2. Select the bookmark you want to delete.
3. Click the **Delete** button.

**Importing Bookmarks from Previous Versions**

All Bookmarks you created in previous versions of Encoder Pro or Code It Fast are automatically imported into this product.
**Exception:** Bookmarks from versions 3.0, and those from versions older than 2.4.1 are not automatically imported. If you have questions, please contact Technical Support at (800) 765-6797.

### USING STICKY NOTES

Sticky Notes are custom notes you or a System Administrator create for selected codes. You can add one note to multiple codes. You can also add multiple notes to any given code.

In order to view all the Sticky Notes either you or the System Administrator have created, you must open the Sticky Notes dialog box.

To open the Sticky Notes dialog box use either of the following methods:

- Click the **Sticky Notes** button 📀
- Select **Sticky Notes** from the View menu

The **Code** column displays all codes that have a Sticky Note. The **Description** column gives the code’s description. The **Date Modified** column shows the date and time the Sticky Note was added or modified. The **Note Name** column shows the name you or the System Administrator typed in when creating the Sticky Note. In order to view the note itself, you must click the **View Note** button.

### Multiple-User Version Note:

If you have the multiple-user version of this program, the Sticky Notes dialog box contains a **Global** tab. Click this tab to view global sticky notes added by the System Administrator. To add, edit, or delete a global sticky note, you must login as the Administrator. Refer [System Administrator Login](#) for instructions.
View Only Check Boxes

The default is for all sticky notes to appear when you first see the Sticky Notes dialog box. If you want to narrow your view to only certain types of codes, uncheck the code set(s) you aren’t interested in viewing (ICD-9 Vol. 1, ICD-9 Vol. 3, CPT, or HCPCS).

Links to the Code Detail

The Sticky Notes dialog box contains code number links that take you to the appropriate code in the Code Detail. You can access the links by selecting the code and then clicking the Go to Code button. Clicking this button exits you from the dialog box and takes you to the selected code.

Balloon Help

Hovering your mouse over any pink flag in the Code Detail shows you the text of that Sticky Note. Your View Tab in the Preferences dialog box determines whether a personal or global note appears when a code has both a personal and a global note.

If you have assigned multiple notes to a code, the balloon help tells you, “This code has multiple sticky notes assigned. Use the Sticky Notes dialog to select a specific note to view.”

Color Code Box Links

When you double-click on a Sticky Note’s blue link in the color codes box, the View Sticky Notes dialog box (refer to page 75) opens. If you have multiple notes assigned to the selected code, then double-clicking this link opens the Sticky Notes dialog box and selects the first note for the code.

Sticky Notes Update

The Sticky Notes dialog box doesn’t contain any codes or sticky notes when you first install this program. You must add all codes and sticky notes to the dialog box. If you are installing over a previous version, all sticky notes are preserved. However, if you in a previous version had a sticky note assigned to a code that the AMA has decided to delete, you are shown this warning dialog box when you first open the Sticky Notes dialog box

```
You have sticky notes assigned to invalid codes.

Click Delete to remove the sticky notes for all invalid codes.

Click Save to keep the sticky notes. If you choose this option, you can use Encoder Pro to look up codes and create a new sticky note for a valid code. You can transfer the sticky note from an invalid code to the new sticky note by using Ctrl+C to copy the note from the invalid code and then Ctrl+V to paste the text into the new sticky note box.

[ ] Discontinue showing this dialog

[Delete] [Save]
```

Take the appropriate actions according to your needs.
Adding a New Sticky Note

To add a sticky note for a code selected in the Code Detail:

1. Click the **Add** button from the toolbar or select **Add** from the Edit menu to open the Add Code dialog box.

   ![Add Code Dialog Box]

   The Add Code dialog box lists the code and description of the selected code. You choose to add the code to your personal sticky notes. If you are logged on as a System Administrator, you may also choose to add the code to global sticky notes.

2. Click the Sticky Notes **Personal** or **Global** check box to specify you are adding a sticky note to the selected code.

3. Click **OK** to close the **Add Code** dialog box and open the View Personal (or Global) Sticky Note dialog box.

4. Type the name you’d like to give the Sticky Note in the **Sticky Note Name** field, and then your comments in the text box below it. Note that there is a 4,000 character limit for sticky note text.

5. Click **OK** to close the dialog box and save your comments. Or, click **Cancel** to close the dialog box without saving.

**Shortcut**

To quickly add a code to the Sticky Notes dialog box without opening the Add Code dialog box:

1. Right-click the desired code in the Code Detail.

2. The **Add Code** shortcut menu appears. Click **Add to Personal (or Global) Sticky Notes**.

   ![Add Code Shortcut Menu]

CPT only © 2005 American Medical Association. All rights reserved.
The View Personal (or Global) Sticky Note dialog box opens and the code you selected and its description appears.

3. Type the name you’d like to give the Sticky Note in the Sticky Note Name field, and then your comments in the text box below it.

**Sticky Note Indicator**

When a sticky note has been created for a code and you select it in the Code Detail, you see the Sticky Notes icon in the color code box below the Code Detail, plus a pink flag next to the code itself.

**Viewing or Editing an Existing Note**

In order to read or edit an Sticky Note you have previously created, you must open the View Sticky Note (either Personal or Global depending on whether you are logged in as the System Administrator) dialog box.

There two ways to access this dialog box:

- Click the **View Note** button from within the Sticky Notes dialog box (refer to page 72).
- Double-click the blue Sticky Note link for a selected code in the Color Code box in the lower portion of the Code Detail. Note that if you have multiple notes assigned to the selected code, then double-clicking this link opens the Sticky Notes dialog box and selects the first note for the code.

The **Date Added or Modified** field shows when the Sticky Note was first added or when it was last modified.

The **Sticky Note Name** field shows the name you or the System Administrator typed in when creating the Sticky Note. Or, if you are in this dialog box as a result of adding a new Sticky Note, it is where you type in a new Note Name. If you are viewing a Global Sticky Note, you have to be logged in as the System Administrator in order to change this field.
The text box below these two fields displays the note itself and is editable. If you are viewing a Global Sticky Note, you have to be logged in as the System Administrator in order to change this field.

The **Selected Code** field displays the code you highlighted from the Code Detail.

The **Enter Codes** field allows you to connect other codes to this same Sticky Note by typing them in. After entering the associated code(s), click the **Assign** button to move them to the **Codes Assigned to Sticky Note** field.

The **Codes Assigned to Sticky Note** field displays the codes and descriptions of all codes that have been assigned this particular sticky note.

The **Unassign** button allows you to delete any code from this sticky note.

The **Sticky Notes** button takes you to the Sticky Notes dialog box which lists all Sticky Notes.

### Deleting an Existing Note

1. Open the Sticky Notes dialog box by either clicking the **Sticky Notes** button or by going to the View menu and selecting **Sticky Notes**.
2. Click the code number of the sticky note you wish to delete.
3. Click the **Delete** button.

**Note:** Use the **Delete** button only to delete the entire sticky note. If you want to delete a block of text from the sticky note, you must click the **View Note** button.

### Importing Sticky Notes from Previous Versions

All Bookmarks you created in previous versions of Encoder Pro or Code It Fast are automatically imported into this product.

**Exception:** Sticky Notes from versions 3.0, and those from versions older than 2.4.1 are not automatically imported. If you have questions, please contact Technical Support at (800) 765-6797.

### USING THE NOTEPAD

**Note:** If you are using Encoder Pro Expert, the Notepad and all associated buttons are named “Compliance Notepad.”

The Notepad functionality is used to temporarily store codes, which can then be copied to the Windows Clipboard. The advantage of using the Notepad is you can perform several searches and then send all the codes to the clipboard at one time. You can also use the Compliance Notepad to run the Compliance Edit (EXPT only).

You open the Notepad dialog box by clicking the **Notepad** button or selecting **Notepad** from the View menu.
Notepad Fields

The Notepad dialog box presents codes in two major groupings. A code when added is placed in either the **Diagnosis Codes** field or the **Procedure, Service and/or Supply Codes** field.

The **Modifiers** field is comprised of a drop-down list and an **Append** button.

Notepad Buttons:

- The **Append** button is described in **Appending Modifiers**.
- The **Add** button is described in **Adding Codes to the Notepad**.
- The **Delete** button is described in **Deleting Codes**.
- The **Duplicate** button is described in **Duplicating Codes**.

The **Clear** button is active only when there is at least one code entered in the **Diagnosis Codes** field or the **Procedure, Service and/or Supply Codes** field. When you click this button, all of the contents of the Notepad are deleted.

The **Designate Primary** button is active only when there is at least one code entered in the **Diagnosis Codes** field or the **Procedure, Service and/or Supply Codes** field. When clicked, the program first checks to make sure no other code is already assigned as primary (there can be only one primary code per code/description box).

- If no codes have been selected as primary, the Make Primary Code dialog box displays to confirm that you want to designate the selected code as Primary.
- If a code is already selected as primary, the New Primary Code dialog box displays to tell you that only one code can be considered primary and that continuing with this action makes the selected code the primary code.
- If you want to deselect a code as primary, you select the code that is primary and click the **Designate Primary** button. The Deselect Primary Code dialog box displays to inform you that this code is already designated as primary and that continuing with this action turns off the Primary designation.
Once a selected code is made primary, a check appears in the * field. If a code is
deselected as primary, then the check no longer appears.

The **Copy to Clipboard** button is described in Sending Data to the Clipboard.
The **Edit Compliance** button, available only in EXPT, allows you to perform a code
validation edit from this dialog box. It is active only when there is at least one code
entered in the **Diagnosis Codes** field or the **Procedure, Service and/or Supply
Codes** field. When clicked, you are presented with the **Compliance Edit** dialog box.
For further information regarding Compliance Editing, refer to Compliance Edit (EXPT
only).

**Adding Codes to the Notepad**

You can add codes to the Notepad from within the Notepad dialog box or from the Code
Detail.

To **add a code to the Notepad from within the Notepad dialog box:**

1. Click the **Add** button.
2. Type in the code.
3. Click **OK**.

To **add a code to the Notepad from the Code Detail:**

1. Click the code to select it.
2. Open the Add Code dialog box by clicking **Add** button from the toolbar or
by selecting **Add** from the Edit menu.
3. Check the Notepad check box.
4. Click **OK**.

**Shortcut**

Right-click on the code in the Code Detail and select **Add to Notepad** from the
Right-Click menu.

**Appending Modifiers**

CPT and HCPCS modifiers that are specific to a code selected in the Notepad are
available in the drop-down list in the Modifiers section of the Notepad dialog box.
To append a modifier to a code in the Notepad:

1. Select a CPT or HCPCS code to which you want to append modifiers.
2. Click the drop-down arrow to the right of the **Modifiers** field to display a list of applicable modifiers.
3. Select the desired modifier.
4. Click the **Append** button to attach the modifier to the selected code. The code appears with the modifier attached.
5. Click **OK** to save changes and close the dialog box.

**Duplicating Codes**

To duplicate a row in the Notepad:

1. Select the code you want to duplicate.
2. Click the **Duplicate** button to insert a copy of the same code in the Notepad code list.

**Note:** Right-click in the Notepad list to open a shortcut menu. Use this menu as another way to add, delete, and duplicate, and clear all codes.

**Deleting Codes**

To delete a row from the Notepad:

1. Under the **Contents** tab, select the row you want to delete.
2. Click the **Delete** button to remove the code from the Notepad.

**Sending Data to the Clipboard**

You can copy just the codes or both the codes and descriptions to the clipboard. To send the Notepad information to the clipboard, click the **Copy to Clipboard** button. Use the **Copy** tab in the Preferences dialog to specify whether codes or both codes and descriptions are copied. For various preferences regarding this functionality, refer to **Copy Tab**.

**USING THE COPY FUNCTION**

**Copying Codes and Descriptions**

When you select a code in the Code Detail, you use **Ctrl+C** or the **Copy** option under the **Edit** menu to copy the code and description directly to the Windows™ clipboard. You can select only one code at a time because each code is considered a link to the Code Detail. For various preferences regarding this functionality, refer to **Copy Tab** in the Preferences section of this manual.
Copying Text

You can also use the copy function to copy all or a portion of text from most code-specific dialog boxes.

To copy text:

1. Use your mouse to select the portion of text you want to copy.
2. Click Ctrl+C to copy the text to the Windows™ clipboard.

Copying to the Clipboard

From the Windows™ clipboard, you can paste codes from your program into other Windows software (e.g., billing program, electronic claim form, etc.). Ingenix’s Encoder Pro suite provides two ways for copying codes, descriptions, and other information to the clipboard.

- Ctrl+C or the Copy option under the Edit menu copies the selected code line or block of text directly to the clipboard.
- Adding codes to the Notepad temporarily stores codes and descriptions before you send them to the clipboard. Notepad features also let you append modifiers to CPT and HCPCS codes.

Note: Please consult your Windows™ system documentation for information on using the Windows Clipboard.

PRINTING

Encoder Pro lets you print general information such as Tabular Results, Code Detail (codes and descriptions), the Bookmarks list, and Notepad contents. You can also print information in any code-specific dialog box, based on the code you have selected. Note that some checkboxes are not available depending on the product you purchased.

To use the Print Report dialog box:

1. Click the Print button or select Print from the File menu. The Print Report dialog box appears.
2. Select the item(s) you want to print.
3. Click the Setup button to display the Page Setup dialog box.
   You can also access this dialog box by selecting Page Setup from the File menu.
   Use the Page Setup dialog box to identify the type of printer you use, to specify
   the paper tray, and to set up other print preferences.
4. Click the Print button.

General Reports

**Code Detail.** For CPT and HCPCS codes, prints the current screen view in the Code
Detail. For ICD-9-CM codes, prints all fourth- and fifth-digit codes, excludes/includes,
modifiers, and other tabular information for the currently selected 3-digit category.

**Tabular Results.** Prints codes and descriptions of all results for the current search.
Number of lines printed is based on the number of total results, not the number of codes
and descriptions in the screen view.

**Index Listing.** Prints codes and descriptions in each tab of the Index Listing for the
current search.

**Bookmarks.** Prints all bookmarks.

**Sticky Notes (All Codes).** Prints all sticky notes.

**Notepad.** Prints contents of the Notepad dialog box.

**AMA Copyright.** Prints the AMA’s copyright information.

**License.** Prints your license agreement with Ingenix.

---

**Notes:** If you are using a Network version of Encoder Pro, you must be logged in as Administrator
in order to have access to the Index Listing and Code Detail reports. These reports are
available to all standalone users.

Both the Index Listing and the Code Detail reports may take some time to process.
Please be patient.

---

Code-Specific Reports

**Guidelines, Notes, References.** Prints AMA guidelines, parenthetical commentary, and
AMA CPT Assistant references for the currently selected CPT code; section notes for the
currently selected HCPCS code; and ICD-9-CM tabular notes and AHA Coding Clinic
references for the currently selected ICD-9-CM code.

**Annotations or Lay Descriptions.** Prints annotations for the currently selected ICD-9-
CM or HCPCS code, and lay descriptions for the currently selected CPT code.

**Modifiers.** Prints range-specific modifiers for the currently selected CPT code and code-
specific modifiers for the currently selected HCPCS code.

**Crosscoder.** This check box is available for EXPT and PRO only. Prints ICD-9-CM
Vol.1, HCPCS, Dental Codes, and Anesthesia codes, as applicable, crossed to the
currently selected CPT code or prints CPT codes crossed to the currently selected ICD-9-
CM Vol. 3 (procedural) code. It prints ICD-9-CM Vol.1, ICD-9-CM Vol. 3 (procedural) codes and CPT codes, as applicable, crossed to the currently selected HCPCS code.

**CCI Unbundle Edits.** This check box is grayed out except in EXPT and PRO. Prints two lists of unbundled codes for the currently selected CPT code: CCI component code unbundles and mutually exclusive code unbundles.

**Local Medical Review Policies (LMRP).** This check box is grayed out except in EXPT and PRO. Prints the ICD-9-CM codes that are considered allowed for a selected CPT code and Medicare Carrier.

**Carriers With LMRP.** This check box is grayed out except in EXPT and PRO. Prints a list of Medicare Carriers with LMRP.

**National Coverage Determinations (NCD).** This check box is grayed out except in EXPT and PRO. Prints the ICD-9-CM codes that are considered allowed for a selected CPT or HCPCS code.

**Medicare Physician Fee Schedule.** This check box is grayed out except in EXPT. Prints Medicare Relative Values, Global Information, and Medicare Rules for the selected CPT code. Or, prints CIM/MCM references for the currently selected HCPCS code.

**CMS Coverage Instructions.** This check box is grayed out in CIFI9. Prints any special coverage instructions. This is not visible in CIFI9.

**DRG Crosscodes.** This check box is grayed out in STND. Prints the DRG code and description, MDC, medical/surgical designation, and Medicare calculation information (GMLOS, AMLOS, RW, etc.) for the currently selected ICD-9-CM code.

**Sticky Note.** Prints the View Sticky Note dialog box contents for the specified code.

**DATA VERSION**

The Data Version dialog box appears when you select **Data Version** from the Help menu. It provides information regarding what version of the data is contained in a given release. Click the blue links at the right of the dialog box to link to the data sources.

The sample below is a snapshot. The versions noted may not match what you see when you access the dialog box from Encoder Pro.
ENVIRONMENT INFORMATION

The Environment Information dialog box appears when you select Environment Info from the Help menu. It provides information regarding the environment detected on your PC. This information is helpful to our Technical Support staff if you need to call in with an issue.

MEDICARE CARRIER/LOCALITY (EXPT AND PRO ONLY)

This dialog box is accessed through the Edit menu’s Select Carrier/Locality option. It allows you to specify a default Medicare carrier to be used when viewing area-specific information such as calculating fees from the Medicare Fee Schedule. It also determines the medical necessity edits that are available for CPT Codes. The data provided in this dialog box comes from the local Medicare review policies (LMRP) and vary by carrier.
CARRIERS WITH LMRP EDITS (EXPT AND PRO ONLY)

This dialog box shows a list of all carriers that have LMRP edits. You access this dialog box by selecting **Carriers with LMRP** from the CPT or HCPCS menu. It can also be accessed via the Right-Click menu. Both methods are active only when you select a code with LMRP edits from any carrier.

The dialog box has three columns showing the carrier number, name of the carrier, and the state abbreviation. From this dialog box you can go directly to the **LMRP Medical Necessity Edits (EXPT and PRO only)** dialog box by using the built-in links. To link to the appropriate LMRP edits, pick a carrier by either selecting it and clicking the **Show Edits** button or double-clicking it to see the LMRP Medical Necessity Edits dialog box.
E/M, Compliance, and Exam Tools

E/M ASSISTANT (EXPT AND PRO ONLY)

If you are searching for a CPT E/M code that is based on key components, the E/M Assistant wizard can be a useful tool for finding the correct code. The E/M Assistant helps you make sense of confusing CPT Book concepts like levels of service and key components. Through the E/M Assistant, you identify place of service, type of service, and other relevant aspects of the E/M service. The E/M Assistant determines which code(s) are appropriate.

The total E/M Assistant is comprised of a series of dialog boxes called a wizard. The dialog boxes you are presented as you click through the wizard change depending on your previous selections. Keep in mind that not all the dialog boxes/menus discussed below appear every time you use the E/M Assistant, nor are all dialog boxes or menu options discussed here. For detailed explanations of E/M terms, please consult the introduction to the E/M codes in CPT.

Note: The E/M Assistant includes codes that are based on level of service.

Select Service

You open this dialog box by selecting E/M Assistant from the File menu. It also opens automatically when you enter a key term (e.g., office) that describes an E/M service that is reported by a CPT code with a key component. In this first screen, Select Service, you are to select the type of service and then click Next. This will take you to the Select Visit dialog box. To exit out of the E/M Assistant, click Cancel.
Here are the *CPT Book* guidelines that can help you determine which menu selections are appropriate (not all menu selections are referenced here):

- Select outpatient unless the patient has been admitted as an inpatient to a healthcare facility.
- Select inpatient hospital for patients admitted as inpatients in a hospital or “partial hospital” setting.
- Select consultations when service is provided by a physician whose opinion or advice regarding evaluation and/or management of a specific problem is requested by another physician or other appropriate source.
- Select emergency if the facility is an organized hospital-based facility for the provision of unscheduled episodic services to patients who present for immediate medical attention. The facility must be available 24 hours a day.
- Select nursing for care provided in a skilled nursing facility (SNF), intermediate care facility (ICF), long term care facility (LTCF), or psychiatric residential treatment center.
- Select domiciliary for rest homes or custodial facilities for the place of service that provides long-term room, board, and other personal assistance services.
- Select home for services provided in a private residence.

**Select Visit**

This dialog box appears after you click the **Next** button from the Select Service dialog box. The contents of this dialog box depend on which of the seven service types you selected in the Select Service dialog box. The Select Visit dialog boxes allow you to select the visit type, based on the selection made in the previous dialog box. Once you’ve selected the appropriate radio buttons, simply click **Next** to move to the Key Components dialog box. To go back to the previous screen to change your selection in the Select Service dialog box, click **Back**.

Here are *CPT Book* guidelines that can help you determine patient status:

- According to the *CPT Book*, a new patient “has not received any professional services from the physician or another physician of the same specialty who belongs to the same group practice, within the past three years.”
- If the physician is on call or covering for another physician, the patient status is based on the relationship with the physician who is not available.

Here are the *CPT Book* guidelines that can help you determine which menu selections are appropriate (not all menu selections are referenced here) for type of care in an inpatient setting:

- Select initial type of care for services that are the first inpatient encounters with the patient by the admitting physician.
- If the patient is admitted to the hospital as an inpatient from another site of service (e.g., emergency department, physician’s office, etc.), all E/M services “provided by that physician in conjunction with that admission are considered part of the initial hospital care when performed on the same date as the admission,” according to the *CPT Book*. 

CPT ONLY © 2005 AMERICAN MEDICAL ASSOCIATION. ALL RIGHTS RESERVED.
- Select subsequent type of care for services that include review of the medical record and diagnostic study results, and changes in the patient's status since the last assessment by the physician.

Here are the CPT Book guidelines that can help you determine counseling and/or coordination care time:

- Counseling and/or coordination of care includes the “face-to-face time in the office or other outpatient setting or floor/unit time in the hospital or nursing facility.”
- Select “More than 50 percent of encounter” if the counseling and/or coordination of care dominates the physician/patient and/or family encounter. According to the CPT Book, the “extent of counseling and/or coordination of care must be documented in the medical record.”

Here are the CPT Book guidelines that can help you determine which menu selections are appropriate for type of consultation:

- Select initial to identify a new consultation. According to the CPT Book, “Follow-up visits in the consultant's office or other outpatient facility that are initiated by the physician consultant” should be identified as an office visit rather than a consultation. In this case, click Back to reselect the type of service.
- For inpatients, “only one initial consultation should be reported by a consultant per admission.”
- Select follow-up if the service is a completion of the initial consultation or if subsequent consultative visits are requested by the attending physician.
- Follow-up consultation codes are not appropriate if, subsequent to the completion of a consultation, the consulting physician “assumes responsibility for management of a portion or all of the patient's conditions,” according to the CPT Book. Click Back to reselect the type of service as attendance or visit.
- Select confirmatory for a consultation requested by a patient and/or family member.
- Report Modifier -32 if a confirmatory consultation is required by a third-party payer.

<table>
<thead>
<tr>
<th>Select Service Option:</th>
<th>Select Visit dialog box you will be presented:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outpatient</td>
<td><img src="image" alt="Outpatient Visit Dialog Box" /></td>
</tr>
</tbody>
</table>
Select Service Option:

Inpatient

Consultations

Emergency

Nursing
Select Service Option: | Select Visit dialog box you will be presented:
---|---
Domiciliary | ![Image]
Home | ![Image]

**Key Components**

This dialog box allows you to view the key components based on the *CPT Book* guidelines. It is up to you to determine which code is appropriate, based on the level of service documented in the medical record.

**Exception:** There are four scenarios where radio buttons clicked from the Select Visit dialog box do not result in you receiving a Key Components dialog box. Instead, you see a Code Result dialog box. Therefore, in these scenarios, you do not need or have access to the Exam Calculator. These four exceptions are Inpatient/Hospital Discharge Services, Inpatient/Observation Care Discharge Services, Emergency/Other Emergency Services, and Nursing/Nursing Facility Discharge Services.

This Key Components dialog box consists of three tabs: **Codes**, **Definitions**, and **Guidelines**. The default tab it opens to is always the Codes tab, as shown in the table below.

**Code Result**

There are four scenarios where radio buttons clicked from the E/M Assistant Select Visit dialog box do not result in you receiving a Key Components dialog box. Instead, you see a Code Result dialog box. Therefore, in these scenarios, you do not need or have access to the **Exam Calculator (EXPT only)** button. These four exceptions are:

- Inpatient/Hospital Discharge Services
- Inpatient/Observation Care Discharge Services

CPT only © 2005 American Medical Association. All Rights Reserved.
- Emergency/Other Emergency Services
- Nursing/Nursing Facility Discharge Services.

This Code Result dialog box shows CPT codes related to the type of service and visit being tracked. You may select one of the codes and then click the Select button to jump to that code in the Code Detail. Otherwise, clicking Finish takes you back to the product’s main screen.

<table>
<thead>
<tr>
<th>Select Visit Option</th>
<th>Dialog box you will be presented:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outpatient/New Patient</td>
<td><img src="image1" alt="Outpatient/New Patient Dialog Box" /></td>
</tr>
<tr>
<td>Outpatient/Established Patient</td>
<td><img src="image2" alt="Outpatient/Established Patient Dialog Box" /></td>
</tr>
<tr>
<td>Inpatient/Initial Hospital Care - New or Established</td>
<td><img src="image3" alt="Inpatient/Initial Hospital Care Dialog Box" /></td>
</tr>
<tr>
<td>Inpatient/Subsequent Hospital Care</td>
<td><img src="image4" alt="Inpatient/Subsequent Hospital Care Dialog Box" /></td>
</tr>
<tr>
<td>Select Visit Option:</td>
<td>Dialog box you will be presented:</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Inpatient/Observation or Inpatient Care Services (Admissions/Discharges)</td>
<td><img src="image1" alt="Dialog box image" /></td>
</tr>
<tr>
<td>Inpatient/Hospital Discharge Services</td>
<td><img src="image2" alt="Dialog box image" /> <em>Does not have access to the Exam Calculator.</em></td>
</tr>
<tr>
<td>Inpatient/Initial Observation Care – New or Established</td>
<td><img src="image3" alt="Dialog box image" /></td>
</tr>
<tr>
<td>Inpatient/Observation Care Discharge Services</td>
<td><img src="image4" alt="Dialog box image" /> <em>Does not have access to the Exam Calculator.</em></td>
</tr>
</tbody>
</table>
Select Visit **Option:**  
Consultations/Office or Other Outpatient Consultations – New or Established  

<table>
<thead>
<tr>
<th>Type of Service</th>
<th>Components</th>
<th>Established or New Components Requested</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Consultations/Initial Inpatient Consultations – New or Established  

Consultations/FollowUp Inpatient Consultations – Established  

Consultations/Confirmatory Consultations – New or Established
<table>
<thead>
<tr>
<th>Select Visit Option:</th>
<th>Dialog box you will be presented:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency/New or Established Patient</td>
<td><img src="image1.png" alt="Emergency/New or Established Patient" /></td>
</tr>
<tr>
<td>Emergency/Other Emergency Services</td>
<td><img src="image2.png" alt="Emergency/Other Emergency Services" /></td>
</tr>
<tr>
<td>Nursing/Comprehensive Nursing Facility Assessments – New or Established</td>
<td><img src="image3.png" alt="Nursing/Comprehensive Nursing Facility Assessments – New or Established" /></td>
</tr>
<tr>
<td>Nursing/Subsequent Nursing Facility Care – New or Established</td>
<td><img src="image4.png" alt="Nursing/Subsequent Nursing Facility Care – New or Established" /></td>
</tr>
</tbody>
</table>
Select Visit **Option:**

<table>
<thead>
<tr>
<th>Option</th>
<th>Dialog box you will be presented:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nursing/Nursing Facility Discharge Services</td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
</tbody>
</table>

*Does not have access to the Exam Calculator.*

<table>
<thead>
<tr>
<th>Option</th>
<th>Dialog box you will be presented:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domiciliary/New Patient</td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Dialog box you will be presented:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domiciliary/Established Patient</td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Dialog box you will be presented:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home/New Patient</td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
</tbody>
</table>
Select Visit Option: Dialog box you will be presented:

<table>
<thead>
<tr>
<th>Home/Established Patient</th>
</tr>
</thead>
</table>

**Codes Tab**

All columns within this tab’s view are non-editable. From the **Code** column you can select a code and double-click it to go to that code in the Code Detail. The codes that display match the Result value that corresponds with the visit status selected in the E/M Assistant - Select Visit dialog.

- The **History** column shows what type of History is required to be submitted.
- The **Examination** column shows what type of exam is required.
- The **Medical Decision Making** column shows how complex the decision-making is for this visit.
- The **Problem Severity** column provides a value for the severity of the problem.
- The **Time** column shows how much time the visit is expected to take.

**Definitions Tab**

Selecting this tab gives you a non-editable text field that provides definitions for terms used. The text presented applies to the range of codes listed in the Codes tab and is not code-specific.

**Guidelines Tab**

Selecting this tab gives you a non-editable text field that provides CPT guidelines that assist in determining which codes should be used. The text presented applies to the range of codes listed in the Codes tab and is not code-specific.

**Exam Calculator Button (EXPT only)**

When the **Exam Calculator** button is clicked, the Key Components dialog box stays open but the Exam Calculator - Select Examination dialog box opens as the active dialog box.

CPT ONLY © 2005 AMERICAN MEDICAL ASSOCIATION. ALL RIGHTS RESERVED.
Specifics of Evaluation and Management Coding

The levels of E/M services define the wide variations in skill, effort, time, responsibility and medical knowledge required for preventing or diagnosing and treating illness or injury, and promoting optimal health.

At first glance, selecting an E/M code appears to be complex, but the system of coding medical visits is actually fairly simple once the requirements for code selection are learned and used.

Levels of E/M Services

Codes for E/M services are categorized by the place of service (e.g., office or hospital) or type of service (e.g., critical care or preventive medicine services). Most of the categories are further divided by the status of the medical visit (e.g., new vs. established patient or initial vs. subsequent care).

The narratives for the levels of most E/M services include seven components. The key components (history, examination and medical decision making) are most often used to select the appropriate level of service code. Information regarding at least two of the three components for inpatient or outpatient follow-up visits - and all three for consults and inpatient or outpatient initial visits - must be documented in the patient’s record to substantiate most levels of service.

The four remaining components are called “contributory components” and are counseling, coordination of care, nature of presenting problem and time. Counseling and coordination of care need not be provided at every patient visit. However, when counseling and coordination of care take up more than 50 percent of the total visit time (face-to-face in the office or other outpatient setting or floor/unit time in the hospital or nursing facility), and the time spent is specifically documented in the chart, then time is the determining factor in selecting an E/M code. Time is also the controlling factor in such E/M services as critical care and prolonged services.

Time factors (total length of time for the encounter and total length of time for the counseling or coordination of care) must be documented in the medical record when time is used to determine a level of service.

The various levels of service for each component are described below and correlate to the CMS’s 1997 Documentation Guidelines for Evaluation and Management Services. For example, an expanded problem-focused history includes the chief complaint and a brief history of the present illness and a system review focusing on the patient’s problems.
Key Components

1. History. The history, the first of the three “key” components described by CPT, must always include a chief complaint. Even if the chief complaint describes that the patient is presenting for follow-up of a previous problem, the reason for the visit is clear. The other areas of history are:
   - History of Present Illness
   - Review of Systems
   - Past Medical History, Family Medical History, Social History.

Within each area of history, there is basic information that makes up the elements of the history. These elements are described below in detail. Once documented, the elements are then quantified to substantiate the level of history.

The History of Present Illness includes information described by the patient about the current condition including
   - Location
   - Severity
   - Timing
   - Modifying Factors
   - Quality
   - Duration
   - Context
   - Associated Signs and Symptoms

An explanation of each of these elements follows.

Location: Refers to a specific location of the problem. For example, pain in the groin area, elbow pain, headache

Severity: Description of the severity of the presenting problem

Timing: Refers to the interval of the pain or suffering. For example, every night, in the middle of the night, constant pain, comes and goes

Modifying Factors: Information about how the pain is modified by other factors. For instance, "pain is relieved by standing erect"; "headache somewhat better after taking aspirin"

Quality: Description of the pain sensation, such as dull, sharp, aching, stinging, and so forth

Duration: The patient will describe an approximate duration of the symptoms. For example: For the last week; since yesterday; it began when I fell this morning

Context: Describes how the symptoms began, such as, "after the auto accident"; "after eating out at a restaurant"; "after bumping my head"
Associated Signs and Symptoms: These are other significant signs or symptoms that the patient feels are related to their injury or illness. For example, some dizziness with nausea; swelling with an ankle injury; double vision with headache.

The Review of Systems (examples in parentheses) includes the patient’s inventory of signs and/or symptoms of the body systems described as:

- Constitutional (weight loss, fever, chills, malaise, and so forth)
- Ear, Nose, Throat, and Mouth (hearing loss, sinusitis, sore throat, oral cavities, ulcers)
- Gastrointestinal (nausea, vomiting, diarrhea, constipation, ulcer)
- Integumentary (skin rashes, moles, dryness, lumps, pigmentation)
- Endocrine (polyuria, polydipsia, cold-heat intolerance, diabetes)
- Genitourinary (Desiree, hematuria, nocturia, menopause, hernia)
- Hematologic/Lymphatic (anemia, bruising, bleeding, lymph node enlargement)
- Eyes (diplopia, blurred vision)
- Cardiovascular (chest pain or pressure, palpitations, murmur, hypertension)
- Musculoskeletal (arthritis, joint stiffness, swelling, myalgia, gout)
- Neurologic (dizziness, syncope, seizures, vertigo, weakness, tremor)
- Allergic/Immunologic (allergies to medicine, food, dye; hepatitis, HIV)
- Respiratory (cough, hemoptysis, pleuritic chest pain, wheezing, asthma)
- Psychiatric (depression, agitation, panic-anxiety, memory disturbance).

The physician must elaborate on any positive responses by obtaining further information from the patient.

The Past, Family, and Social History is final element of the history. They are described by:

- Past Medical History: Adult and childhood illnesses or trauma; vaccinations and screenings, and past surgical history
- Family History: Describes marital status (married, widowed, divorced, and so forth), parents, siblings, children, genetic diseases of the family or other familial history
- Social History: Descriptive information about the patient’s habits. For example, smoker, alcohol consumption, drug use, sexual orientation, place of birth, residence, occupation, education level, religion.

These systems may be reviewed by having the patient complete a questionnaire regarding the Review of Systems and Past, Family, and Social histories. The form is then reviewed by the physician to document details with respect to any positive responses.
Quantifying the History

There are four types described in the levels of E/M codes:

Problem-focused: Chief complaint, brief history (one to three elements) of present illness

Expanded problem-focused: Chief complaint, brief history (one to three elements) of present illness, problem-pertinent system review (1 system)

Detailed: Chief complaint, extended history of present illness (four or more elements), problem-pertinent system review extended to include a review of a limited number of additional systems (2 to 9 systems), and pertinent (1 history area) past, family and/or social history directly related to the patient’s problems

Comprehensive: Chief complaint, extended history of present illness (four or more elements), review of systems that are directly related to the problems identified in the history of present illness, plus a review of all additional body systems, and complete past, family and social history.

2. Physical Examination. The physical examination, the second of the three “key” components for evaluation and management, is documented by the physician/physician extender and is then quantified. The following body areas and organ systems compose the elements of the physical examination:

Body Areas:

- Head, including face (normocephalic; scalp)
- Chest, including breasts and axillae (symmetry, skin changes, dimpling, nipple area)
- Neck (trachea-larynx, thyroid [goiter, nodules, mass, tenderness, bruit], crepitus)
- Abdomen (rebound, scars, distension, palpate liver, spleen, tenderness)
- Genitalia, groin, buttocks (visual inspection, nodes)
- Back, including spine (contour, tenderness, swelling)
- Each extremity (clubbing, edema, asymmetry).

Note: Body Areas count only as one element of the examination in quantifying the level of physical examination, even if all body areas are inspected.

Organ Systems:

- Constitutional (general appearance, vital signs: blood pressure, pulse, temperature, respiration, height, weight)
- Eyes (pupils equal, round, reactive to light and accommodation; discs; retinal vessels; extraocular movements)
- Ears, nose, throat (pinnae, external auditory canal, tympanic membrane; mucosa, septum, polyps, turbinate; lips, gingiva, posterior pharynx, tonsils, gag reflex)
Cardiovascular (murmur, rub, gallop, hypertension, peripheral vascular pulses, varicose veins)
Respiratory (breath sounds [wheezes, rales, rhonchi], resonance, contour)
Gastrointestinal (Bowel sounds, soft abdominal bruits, ascites, fluid waves)
Genitourinary (Male: penis, scrotum, hydrocele, hernia; Female: external genitalia, Batholin’s glands, cervix, uterus)
Musculoskeletal (range of motion, strength, atrophy, swelling, tenderness, tone)
Skin (cyanosis, pigmentation, turgor, lesions, ulcers, petechiae, purpura)
Neurological (Romberg, tremor, tic, ataxia, aphasia, reflexes, gait)
Psychiatric (alertness, orientation, memory, calculation, abstract concepts, speech, cortical integration)
Hematologic/Immunologic/Lymphatic (blood specimens, immunoassays, lymph nodes).

Quantifying the Examination:

There are four types indicated in the levels of E/M codes:

1997 Documentation Guidelines for Evaluation and Management Services:

Problem-focused: Perform and document examination of one to five bullet elements in one or more organ systems/body areas from the general multisystem examination OR examination of one to five bullet point elements from one of the ten single-organ-system examinations, shaded or unshaded boxes.

Expanded problem-focused: Perform and document examination of at least six bullet elements in one or more organ systems from the general multisystem examination OR perform and document examination of at least six bullet point elements from one of the ten single-organ-system examinations, shaded or unshaded boxes.

Detailed: Perform and document examination of at least six organ systems or body areas, including at least two bullet elements for each organ system or body area from the general multisystem examination OR perform and document examination of at least 12 elements in two or more organ systems or body areas from the general multisystem examination OR perform and document examination of at least 12 bullet elements from one of the single-organ-system examinations, shaded or unshaded boxes, EXCEPT eye and psychiatric single-system examinations: perform and document at least nine bullet elements, shaded or unshaded boxes.
Comprehensive: Perform and document examination of at least nine organ systems or body areas, with all bullet elements for each organ system or body area (unless specific instructions are expected to limit examination content with at least two bullet elements for each organ system or body area) from the general multisystem examination OR perform and document examination of all bullet point elements from one of the ten single-organ system examinations with documentation of every element in shaded boxes and at least one element in each unshaded box from the single-organ-system examination.

1995 Documentation Guidelines for Evaluation and Management Services:

- Problem-focused: One body area or system
- Expanded problem-focused: Two to seven systems (of which one may be a body area[s]).
- Detailed: Two to seven systems (of which one may be a body area[s] with one organ system being examined and documented in detail).
- Comprehensive: Eight or more organ systems (of which one may be a body area[s]), or a complete single system examination.

3. **Medical decision making.** The medical decision making is the third “key component” of determining the level of evaluation and management service. There are three areas to consider when determining the level of medical decision making:

   - **Number of diagnosis(es) or management options**
   - The following should be considered:
     - All known diagnoses that are being treated
     - Undiagnosed conditions that are being evaluated
     - Treatments that are being used
     - Treatments that are being considered

   - **Amount and complexity of data to be reviewed**
   - The following are considered:
     - Orders and review of all tests - lab, radiology, and medical
     - Discussion of test results with performing physician
     - Independent review of image, tracing or specimen
     - Decision to obtain and review of old records
     - History obtained from someone other than the patient

   - **Risk of complications and/or morbidity or mortality**
   - Look for documentation of the following:
     - Presenting problem(s).
     - Diagnostic procedures ordered
     - Management options selected.
Quantifying the Medical Decision Making

There are point systems associated with the medical decision making much like those in the history and examination components. However, the ultimate conclusion of the level of medical decision making, is based on two of three of the medical decision making areas meeting the definition of the level of decision making. Those definitions are listed below:

Straightforward: Minimal number of possible diagnoses or management options; minimal, if any, amount and complexity of data to be reviewed; and minimal risk of complications and/or morbidity or mortality.

Low complexity: Limited number of possible diagnoses or management options, limited amount and complexity of data to be reviewed, and low risk of complications and/or morbidity or mortality.

Moderate complexity: Multiple number of possible diagnoses or management options, moderate amount and complexity of data to be reviewed, and moderate risk of complications and/or morbidity or mortality.

High complexity: Extensive number of possible diagnoses or management options; extensive amount and complexity of data to be reviewed; and high risk of complications and/or morbidity or mortality.

<table>
<thead>
<tr>
<th>Number of Diagnosis or Management Options (Number x Points = Result)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number</strong></td>
</tr>
<tr>
<td>Self-limited or minor (stable, improved, or worsening)</td>
</tr>
<tr>
<td>Est. problem (to patient); stable, improved</td>
</tr>
<tr>
<td>Est. problem (to patient); worsening</td>
</tr>
<tr>
<td>New problem (to patient); no additional work-up planned</td>
</tr>
<tr>
<td>New problem (to patient); additional work-up planned</td>
</tr>
<tr>
<td>Transfer total to line A of Final Result for MDM table</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Amount and/or Complexity of Data to be Reviewed</th>
<th>Points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review and/or order of clinical lab tests</td>
<td>1</td>
</tr>
<tr>
<td>Review and/or order of tests in radiology section of CPT</td>
<td>1</td>
</tr>
<tr>
<td>Review and/or order of tests in the medicine section of CPT</td>
<td>1</td>
</tr>
<tr>
<td>Discussion of test results with performing physician</td>
<td>1</td>
</tr>
<tr>
<td>Decision to obtain old records and/or obtaining history from someone other than patient</td>
<td>1</td>
</tr>
<tr>
<td>Review and summarization of old records and/or obtaining history from someone other than patient and/or discussion of case with another health care provider</td>
<td>2</td>
</tr>
<tr>
<td>Independent visualization of image, tracing, or specimen itself (not simply review of report)</td>
<td>2</td>
</tr>
<tr>
<td>Transfer total to line B of Final Result for MDM table</td>
<td>TOTAL</td>
</tr>
</tbody>
</table>
### Final Result for Complexity of Medical Decision Making: 2 of 3 required

<table>
<thead>
<tr>
<th></th>
<th>Number of diagnoses or management options</th>
<th>Minimal</th>
<th>Limited</th>
<th>Multiple</th>
<th>Extensive</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Amount and complexity of data to be reviewed</th>
<th>Minimal</th>
<th>Limited</th>
<th>Moderate</th>
<th>Extensive</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Risk of complications &amp;/or morbidity or mortality</th>
<th>Minimal</th>
<th>Low</th>
<th>Moderate</th>
<th>High</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TYPE OF DECISION MAKING</th>
<th>STRAIGHT-FORWARD</th>
<th>LOW COMPLEX</th>
<th>MODERATE COMPLEX</th>
<th>HIGH COMPLEX</th>
</tr>
</thead>
</table>

### Contributory Components

4. **Nature of presenting illness.** The E/M codes divide this into five types:

   - **Minimal:** Problem that may not require the presence of the physician, but service is provided under the physician’s supervision
   - **Self-limited or minor:** Transient problem, and low probability of permanently altered state; or good prognosis with management/compliance
   - **Low severity:** Problem that has a low risk of morbidity or little, if any, risk of mortality without treatment; full recovery is expected without functional impairment
   - **Moderate severity:** Problem that carries a moderate risk of morbidity or mortality without treatment, uncertain outcome or increased probability of prolonged functional impairment
   - **High severity:** Problem that has a high to extreme risk of morbidity, moderate to high risk of mortality without treatment, or high probability of severe, prolonged functional impairment

   The level of the “severity of the presenting problem” may vary during the encounter, based on the physician’s documented evaluation of the patient; chart documentation should clearly define the findings and reflect the thought process of the physician in ordering diagnostic or therapeutic services to support medical necessity for those services. This component is the foundation for establishing the level of service based on “medical necessity.”

5. **Counseling.** This is performed when one or more of the following areas are discussed face-to-face with the patient and/or family:

   - Diagnostic results, impressions or recommended diagnostic studies
   - Prognosis
   - Risks and benefits of management (treatment) options
   - Instructions for management (treatment) or follow-up
   - Importance of compliance with chosen management (treatment) options
   - Risk factor reduction
   - Patient and family education
The counseling is only considered when it is the dominant factor in determining the level of evaluation and management service (over 50 percent of the visit time is spent in this activity). See “Time” below.

6. **Coordination of care.** This includes contact with other physicians or health care practitioners on behalf of the patient. When coordination of care does not include a patient encounter on that day, the services should be reported using the case management codes. However, the case management codes are not covered by many third-party payers.

Coordination of care in the inpatient setting does not require face-to-face time with the patient but includes time spent with parties who have assumed responsibility for decisions regarding the patient’s care. Time spent reviewing records or test results or other medical data may be included in quantifying the time.

Coordination of care is only considered when it is the dominant factor in determining the level of evaluation and management service (over 50 percent of the visit time is spent in this activity). See "Time" below.

7. **Time.** This is used in selecting an E/M code only when counseling or coordination of care represents more than 50 percent of the time the physician spent face to face (outpatient) or bedside and on the floor or unit with the patient or family (inpatient). *Both time elements* - total length of time for the visit and total length of time involved in counseling or coordination of care, as well as the nature of the counseling and coordination of care must be documented explicitly in the medical record. In the *CPT Book*, additional time qualifiers are found, “This includes time spent with parties who have assumed responsibility for the care of the patient or decision making whether or not they are family members (e.g., foster parents, person acting in locum parentis, legal guardian).”

8. **Preventive medicine services.** Encounters for preventive medicine evaluation and management, such as a routine annual health screening examination, are provided to infants, children, adolescents and adults. Special E/M code categories are provided for these encounters; categories are assigned according to whether the patient is new or established and according to the age of the patient.

9. **Prolonged services.** Encounters in which the time required by the physician to provide a given service exceeds, by at least 30 minutes, the amount of time usually required to provide the service. Separate code categories are provided for services *with* face-to-face contact with the patient, and for services *without* direct face-to-face contact with the patient. Prolonged service codes are used *in addition* to other E/M codes assigned on the same date.

**Terms Commonly Used in E/M Codes**

**Chief complaint:** The diagnosis, condition, problem, symptom or other reason the patient scheduled a visit with the physician, as stated by the patient and generally recorded in the patient’s own words. A chief complaint must be documented for all levels of problem-oriented E/M service codes (99201-99499).

**Complete past, family and social history:** A comprehensive review of all elements of the patient’s past, family and social history. For Medicare, two or all three history areas depending on the category of E/M service must be documented.
**Complete system review:** A narrative of organ systems reviewed including systems related to the problems identified in the chief complaint and/or history of presenting illness plus a review of all other systems. All positive responses and pertinent negatives should be documented. For remaining systems, a notation indicating that “all other systems are negative” is permissible; otherwise, at least 10 systems must be individually documented.

**Comprehensive physical examination:** Examination of at least nine organ systems or body areas which must include all bullet point elements within each of the nine systems/areas under the multisystem exam OR examination of all bullet point elements from one of the 10 single-organ-system examinations with documentation of every element in the shaded boxes and at least one element in each unshaded box. Or, under CMS’s 1995 Documentation Guidelines for Evaluation and Management Services, examination of at least eight organ systems or one comprehensive single system examination.

**Concurrent care:** Medical care provided by two or more physicians on the same day. If care is medically necessary, third-party payers usually pay both physicians. Generally, payers expect the physicians to be of different specialties and caring for different conditions or different aspects of the same condition or disease process.

**Detailed physical examination:** Examination of at least six organ systems or body area, including at least two bullet point elements for each organ system or body area from the general multisystem examination OR examination of at least 12 bullet point elements from one of the single-organ-system examinations. The requirements for the eye and psychiatric single-system examinations must include at least nine point bullet elements. Or, under CMS’s 1995 Documentation Guidelines for Evaluation and Management Services, examination of at least two to seven organ systems, with at least one system being documented in detail.

**Expanded problem-focused physical examination:** Examination of at least six bullet point elements in one or more organ systems from the general multisystem examination OR examination of at least six of the bullet point elements from one of the 10 single-organ-system examinations, shaded or unshaded boxes. Or, under CMS’s 1995 Documentation Guidelines for Evaluation and Management Services, examination of at least two to seven organ systems.

**Established patient:** One who has received professional services face to face within the past three years from a physician or another physician of the same specialty in the same group practice. If a patient is seen by a physician who is covering for another physician, the patient will be considered the same as if seen by the physician who is unavailable.

**Extended history of present illness:** A detailed narrative of the presenting illness, including the history elements of location, quality, severity, duration, timing, context, modifying factors and/or associated signs and symptoms related to the presenting problems. The narrative also should detail the onset of new problems, or any changes since the last visit, if it is an established condition. The status of at least three chronic or inactive conditions is considered extended under CMS’s 1997 Documentation Guidelines for Evaluation and Management Services.

**Extended system review:** A narrative of organ systems reviewed directly related to the chief complaint and/or history of present illness plus a review of a limited number of additional systems. The review of additional systems helps the physician define the problem, helps establish differential diagnoses, helps establish the necessity for
diagnostic tests and serves as a baseline for information about other systems that might be affected. Pertinent positives and relevant negatives for each body system should be listed individually. Two to nine systems should be documented. Or, CMS’s 1995 Documentation Guidelines for Evaluation and Management Services, examination of at least one organ system.

**Family history:** Record of the health of family members, including the health status or cause of death of parents, siblings and children, and specific diseases related to the patient’s chief complaint, history of present illness and/or review of systems.

**Medical decision making:** The level of decision making is based on the nature of the problem at the time of the visit and considers the differential diagnoses, the amount and/or complexity of data to be reviewed and considered (medical records, test results, correspondence from previous treating physicians, etc.), current diagnostic studies ordered, treatment or management options and risk. Risk is further defined as complications of the patient’s condition or the potential for complications, continued morbidity and/or the risk of mortality and any comorbidities associated with the patient’s disease process. Documentation of the elements of medical decision making also provides supporting documentation for medical necessity of levels of E/M services as well as diagnosis and therapeutic services. See Appendix B, “Documentation Guidelines for Evaluation and Management Services, Including all 1997 Physical Exams (General Multisystem and Single-system Exams)” for Medicare’s specific documentation policies.

**Morbidity:** A diseased condition or state.

**Mortality:** The condition of being mortal (death).

**New patient:** One who has not received any professional face to face services within the past three years from the physician or another physician of the same specialty in the same group practice.

**On-call physician encounters:** If the physician is on-call or covering for another physician, the patient’s encounter is classified as it would have been by the physician who is not available. Thus, a locum tenens physician who sees a patient on behalf of the patient’s attending physician may bill for a new patient only if the attending physician has not provided any professional service within a three-year period.

**Past history:** Record of prior illnesses or conditions occurring in childhood and adulthood, such as infectious diseases, allergies, accidents, current medications, hospitalizations and surgical/medical procedures.

**Pertinent past, family and/or social history:** A brief narrative of the elements directly related to the problem(s) identified in the chief complaint, history of present illness or the review of systems. For Medicare, any one or two of the three history areas (depending on the category of E/M service) must be documented.

**Present illness:** Current problem, from the onset of symptoms to the time of the encounter.

**Preventive medicine services:** An evaluation and management service provided as a periodic health screening and/or prophylactic service.

**Problem-focused physical examination:** Examination of one to five bullet point elements in one or more organ systems/body areas from the general multisystem examination **OR** examination of one to five bullet point elements from one of the 10 single-organ-system examinations, shaded or unshaded boxes.
**Problem-pertinent system review:** A narrative of the organ system(s) reviewed related to the system identified in the chief complaint and/or history of present illness. The pertinent positive and negative responses for the system related to the problem should be documented. See Appendix B for the specific organ systems identified by the Medicare program.

**Prognosis:** A forecast of the probable outcome of a condition or disease, and the prospects of recovery and disease residual, depending on the nature of the disease and the patient’s response to treatment.

**Prolonged services:** Inpatient or outpatient services provided by physicians that substantially exceed, by 30 minutes or more, the usual time the service takes to complete.

**Social history:** A review of pertinent past and current activities of the patient, including marital status; employment or occupation; use of drugs, alcohol and tobacco; educational background; sexual history and other related social factors. In some cases, the patient’s avocations and/or hobbies may be significant, such as mountain climbing, skiing, deep water diving and so forth.

**Modifiers Used with E/M Codes**

The following modifiers apply to E/M codes; other modifiers may apply in some situations.

–21 Prolonged Evaluation and Management Services. When the face-to-face or floor/unit service(s) provided is prolonged or otherwise greater than that usually required for the highest level of E/M service within a given category, it may be identified by adding Modifier –21 to the E/M code number or by using the separate five-digit modifier code 09921. A report may also be appropriate.

–24 Unrelated Evaluation and Management Service by the Same Physician During a Postoperative Period. The physician may need to indicate that an E/M service was performed during a postoperative period for a reason(s) unrelated to the original procedure. This circumstance may be reported by adding the Modifier –24 to the appropriate level of E/M service, or the separate five digit modifier code 09924 may be used.
–25 Significant, Separately Identifiable Evaluation and Management Service by the Same Physician on the Day of a Procedure or Other Service. The physician may need to indicate that on the day a procedure or service identified by a CPT Code was performed, the patient’s condition required a significant, separately identifiable E/M service above and beyond the other service provided or beyond the usual preoperative and postoperative care associated with the procedure that was performed. The E/M service may be prompted by the symptom or condition for which the procedure and/or service was provided. As such, different diagnoses are not required for reporting of the E/M services on the same date. This circumstance may be reported by adding the Modifier –25 to the appropriate level of E/M service, or the separate five-digit modifier code 09925 may be used. Note: This modifier is not used to report an E/M service that resulted in a decision to perform surgery. See Modifier –57.

–27 Multiple Outpatient Hospital E/M Encounters on the Same Date. For hospital outpatient reporting purposes, utilization of hospital resources related to separate and distinct E/M encounters performed in multiple outpatient hospital setting on the same date may be reported by adding the Modifier –27 to each appropriate level outpatient and/or emergency department E/M codes (s). This modifier provides a means of reporting circumstance involving evaluation and management services provided by physicians(s) in more than one (multiple outpatient hospital settings[s] (e.g., hospital emergency department clinic). Note: This modifier is not to be used for physician reporting of multiple E/M services performed by the same physician on the same date. For physician reporting of all outpatient E/M services provided by the same physician on the same date and performed in multiple outpatient setting(s) (e.g., hospital emergency department, clinic), see Evaluation and Management, Emergency Department, or Preventive Medicine Service codes. Medicare requires Modifier –GO in place of Modifier –27 at the time of this printing.

–32 Mandated Services. Services related to mandated consultation and/or related services (e.g., PRO, third-party payer, governmental, legislative, or regulatory requirement) may be identified by adding the Modifier –32 to the basic procedure, or the service may be reported using the five-digit modifier code 09932.

–52 Reduced Services. Under certain circumstances a service or procedure is partially reduced or eliminated at the physician’s discretion. Under these circumstances the service provided can be identified by its usual procedure number and the addition of the Modifier –52, signifying that the service is reduced. This provides a means of reporting reduced services without disturbing the identification of the basic service. Modifier code 09952 may be used as an alternative to Modifier –52. Note: For hospital outpatient reporting of a previously scheduled procedure/service that is partially reduced or canceled as a result of extenuating circumstances or those that threaten the well-being of the patient prior to or after administration of anesthesia, see Modifiers –73 and –74.

–57 Decision for Surgery. An E/M service that resulted in the initial decision to perform the surgery may be identified by adding Modifier –57 to the appropriate level of E/M service, or the separate five-digit modifier code 09957 may be used.
Selecting an E/M Code

To select the appropriate level of service, one should take the following steps:

1. Identify the place of service (e.g., office, inpatient hospital, emergency room visit) or type of service (e.g., consultation) provided, and select the appropriate category and subcategory from the CPT Book.

2. Read the E/M documentation guidelines at the beginning of the category and subcategory to determine what special instructions, if any, apply to that subcategory of E/M codes.

3. From the medical record documentation, determine the extent of the history obtained, the examination performed and the complexity of the medical decision making.

4. Review the code narratives in the appropriate category and subcategory. Each narrative includes the specific criteria that must be met or exceeded if the code is to be assigned correctly.

5. Select the code that matches the levels of history, examination and medical decision making involved. (If chart documentation indicates that counseling and coordination of care take up more than 50 percent of the time spent on the face-to-face encounter between the physician and patient and/or family or the time the physician spent bedside and on the floor or unit, use time as the determining factor.)

6. Apply appropriate E/M modifiers, as needed.

**EXAM CALCULATOR (EXPT ONLY)**

The Exam Calculator functionality is presented in a wizard similar to the E/M Assistant (EXPT and PRO only). It assists your coding efforts according to the appropriate exam level based on CMS’s 1997 Documentation Guidelines for Evaluation and Management Services.

**Exam Calculator – Select Examination**

This Exam Calculator – Select Examination dialog box appears when you click the Exam Calculator button from the E/M Assistant – Key Components dialog box. It allows you to determine the appropriate level of service for the Examination key component. It is based on CMS’s 1997 Documentation Guidelines for Evaluation and Management Services for general multi-system examinations and single-organ system examinations.
Exam Calculator – Examination

The radio buttons you click from the Exam Calculator – Select Examination dialog box will determine the contents that will display in the next dialog box of the wizard—the Exam Calculator – Examination dialog boxes as shown below. Within these dialog boxes you select tabs and check boxes from different systems/body areas for the selected examination type.

- The **Examination Type** field shows the selection you made in the previous Select Examination dialog box.
- The tabs presented in this dialog box coincide with the Examination Type you selected in the Select Examination dialog box. You may access as many of them as are appropriate.
- The check boxes change according to what tab you select. You may click all the check boxes that apply in as many tabs as are needed.

<table>
<thead>
<tr>
<th>Select Examination Option:</th>
<th>Examination dialog box you will be presented:</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Multi-System Evaluation</td>
<td><img src="image" alt="Diagram showing examination options" /></td>
</tr>
</tbody>
</table>
Select Examination Option: Examination dialog box you will be presented:

**Cardiovascular**

**Ears, Nose, Mouth and Throat**

**Eyes**

**Genitourinary**

**Hematologic/Lymphatic/Immunologic**
<table>
<thead>
<tr>
<th>Select Examination Option:</th>
<th>Examination dialog box you will be presented:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Musculoskeletal</td>
<td><img src="image" alt="Musculoskeletal Examination" /></td>
</tr>
<tr>
<td>Neurological</td>
<td><img src="image" alt="Neurological Examination" /></td>
</tr>
<tr>
<td>Psychiatric</td>
<td><img src="image" alt="Psychiatric Examination" /></td>
</tr>
<tr>
<td>Respiratory</td>
<td><img src="image" alt="Respiratory Examination" /></td>
</tr>
<tr>
<td>Skin</td>
<td><img src="image" alt="Skin Examination" /></td>
</tr>
</tbody>
</table>
Exam Calculator – Examination Level of Service

This dialog box appears when you select at least one check box from the Exam Calculator - Examination dialog box. It informs you of the examination type that is appropriate based on the radio buttons (elements) selected, according to CMS’s 1997 Documentation Guidelines for Evaluation and Management Services.

The Level of Service field is non-editable and shows the examination type based on the selections made in the Exam Calculator - Examination dialog box. There are four types of examinations that can result in this field:

- Problem-Focused Examination
- Expanded Problem-Focused Examination
- Detailed Examination
- Comprehensive Examination

The text displayed explains the result. The following is an example.
**COMPLIANCE EDIT (EXPT ONLY)**

This dialog box allows you to run a compliance edit for coding conflicts affecting the ICD-9-CM, CPT and/or HCPCS codes that you have selected for the Notepad. It also gives you an opportunity to enter patient data to enhance the compliance edit.

This dialog box appears when you click the **Compliance Edit** button from the Notepad.

The compliance edit identifies:

- CCI unbundle edit conflicts
- LMRP Medical Necessity and NCD conflicts (based on Locality selection).
- ICD-9-CM codes that require an additional digit
- Nonspecific codes
- Commonly miscoded procedures
- Age edit conflicts
- Sex edit conflicts
- ICD-9-CM codes that can’t be primary diagnoses
- Medicare noncovered codes
- CPT codes that can’t be primary procedures
- CPT add-on codes that require primary procedure codes

The **Patient Information** area of the dialog box allows you to input the patient’s date of birth and select the patient’s gender. You are not required to complete these fields to continue with the edit.

For the **Date of Birth**, you may choose to enter the patient’s date of birth if you want the Edit Compliance to check for age edits.

For the **Sex** drop-down list, you can select the patient’s gender if you want the Edit Compliance to check for sex edits.
The **Use Patient Information** check box should be marked if you want the patient’s birth date and gender to be part of the compliance edit.

The **Medicare Carrier / Locality** area shows the Medicare locality information that is used for the LMRP Medical Necessity and NCD edits. You may use the default established in the Select Medicare Carrier/Locality (EXPT and PRO only) dialog box, or you can change it from the drop-down list to view the calculated fee for any Medicare locality.

The **Make default Medicare Carrier / Locality** check box is active only if you select a Medicare Carrier from the Medicare Carrier / Locality drop-down list that is different from that selected in the Select Medicare Carrier / Locality dialo

g box. If the user selects this check box, then the carrier selected in the Medicare Carrier / Locality drop-down list becomes the new default carrier.

Once you’ve adjusted the above fields to your specific needs, you click either the **Cancel** or **OK** button. If you click **Cancel**, the Edit is cancelled. If you click **OK**, the compliance edit is initiated. There are only two possible results after clicking **OK**. These dialog boxes are described in the Additional Help Topics identified below.

### Edit is Completed

This message box tells you that the edit is complete and that no coding conflicts were found. It appears when you click the **OK** button from the Compliance Edit dialog box and no edit conflicts were found.

The **OK** button closes the message box and returns you to the Notepad.

### Edit Conflicts

This dialog box presents you with a report of the codes that have edit conflicts. It appears when you click the **OK** button from the Compliance Edit dialog box and edit conflicts were found.
The **Select** button is available only if a magenta code is selected. Clicking this button takes you back to the Notepad where you take action according to the conflict text. This can also be accomplished by double-clicking the magenta code.

The **Cancel** button closes the dialog box and returns you to the Notepad.

The **Print** button allows you to print a report of the edit conflicts.

The **Help** button takes you to dialog-specific online help.

**Edit Conflicts Tab**

The **Edit Conflicts** tab reports all edit conflicts except the CCI unbundle edit conflicts. The magenta code links take you back to the Notepad where you take action according to the conflict text.

The **Code** column lists each code that is affected by an edit conflict. The magenta code provides you with a link to the Code Detail.

The **Edit Type** column shows either Fail or Caution. Fail denotes that the user should recode. Caution is a warning that the use of the code may be appropriate but has been questioned.

The **Edit Conflict** column shows you the name of the edit conflict.

The **Edit Conflict Description** column gives more information on the conflict.

Here are the possible results:

<table>
<thead>
<tr>
<th>Edit Conflict Name</th>
<th>Edit Conflict Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Digits Required</td>
<td>Code requires additional third, fourth and/or fifth digit to be coded correctly. Either the code category or subcategory contains more specific codes.</td>
</tr>
<tr>
<td>Nonspecific Code</td>
<td>Code is classified as 'unspecified', 'other', or 'ill-defined.' This code may be a valid choice if it most closely describes your diagnosis or procedure, but use only after checking all other options.</td>
</tr>
<tr>
<td>Frequently Miscoded</td>
<td>This code may be a valid choice if it most closely describes the procedure or service, but be aware that this code is frequently miscoded and another code may be more appropriate.</td>
</tr>
<tr>
<td>Male Gender Conflict</td>
<td>Code is a male-specific diagnosis or procedure. Patient sex conflicts with this code.</td>
</tr>
<tr>
<td>Female Gender Conflict</td>
<td>Code is a female-specific diagnosis or procedure. Patient sex conflicts with this code.</td>
</tr>
<tr>
<td>Primary DX Conflict</td>
<td>Code does not report a primary diagnosis. Known as a 'manifestation', this code should only be listed as a secondary diagnosis.</td>
</tr>
<tr>
<td>Additional Digits Required</td>
<td>Code requires additional third, fourth and/or fifth digit to be coded correctly. Either the code category or subcategory contains more specific codes.</td>
</tr>
<tr>
<td>Medicare Noncovered Conflict</td>
<td>Code reports a procedure, service or supply that is not covered by or valid for Medicare.</td>
</tr>
<tr>
<td>Medicare Coverage Conflict</td>
<td>Code reports a procedure, service or supply that has restricted or no coverage from Medicare.</td>
</tr>
</tbody>
</table>
Primary PX Conflict  
Code does not report a primary procedure. Known as an 'add-on' code, this code describes additional intra-service work associated with a primary procedure.

Add-on Without Primary  
Code requires a primary procedure code. Known as an 'add-on' code, this code is always performed in addition to the primary service or procedure and must never be reported as a stand-alone code.

LMRP Edit Conflicts Tab

The LMRP Edit Conflicts tab reports LMRP Medical Necessity edit conflicts. The magenta code links take you back to the Notepad where you take action according to the conflict text.

<table>
<thead>
<tr>
<th>Edit Conflict Name</th>
<th>Edit Conflict Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medical Necessity Conflict</td>
<td>This ICD-9 code is not considered a medically necessary diagnosis for this CPT procedure code, based on the LMRP policies from the selected Medicare Carrier and/or the NCD edits.</td>
</tr>
<tr>
<td>No LMRP Policy Available</td>
<td>There are no LMRP policies or NCD edits associated with this CPT procedure code for the selected carrier. Confirm with your carrier that it is reimbursable if reported with this ICD-9 diagnosis code.</td>
</tr>
</tbody>
</table>
CCI Unbundle Conflicts Tab

The **CCI Unbundle Conflicts** tab reports CCI Unbundle Edits.

The Col. 1 column lists the CPT Code that is considered to be the greater procedure (includes component procedures). The magenta code links take you back to the Notepad where you take action according to the conflict text.

The Col. 2 column lists the CPT Code(s) that are considered to be component edits of the greater procedure in Col. 1. This column may also include codes that are considered mutually exclusive to the code in Col. 1. It only lists codes that were entered into the Notepad, not all codes that are considered component and/or mutually exclusive procedures.

The **Edit Conflict** column shows you the name of the edit conflict.

The **Description** column gives more information on the conflict.

These are the possible results:

<table>
<thead>
<tr>
<th>Edit Conflict Name</th>
<th>Edit Conflict Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCI Component Unbundle</td>
<td>The code in Col. 2 is considered by Medicare to be a component procedure of the code in Col. 1. There are no circumstances in which a modifier would be appropriate. The services represented by the code combination will not be paid separately.</td>
</tr>
<tr>
<td>CCI Component Unbundle - Modifier Allowed</td>
<td>The code in Col. 2 is considered by Medicare to be a component procedure of the code in Col. 1. A modifier is allowed in order to differentiate between the services provided. Separate payment for the services billed may be considered justifiable if a modifier is used appropriately.</td>
</tr>
<tr>
<td>CCI Mutually Exclusive</td>
<td>The codes in Col. 2 is considered by Medicare to be mutually exclusive procedures of the code in Col. 1. There are no circumstances in which a modifier would be appropriate. The services represented by the code combination will not be paid separately.</td>
</tr>
<tr>
<td>Edit Conflict Name</td>
<td>Edit Conflict Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CCI Mutually Exclusive - Modifier Allowed</td>
<td>The code in Col. 2 is considered by Medicare to be a mutually exclusive procedure of the code in Col. 1. A modifier is allowed in order to differentiate between the services provided. Separate payment for the services billed may be considered justifiable if a modifier is used appropriately.</td>
</tr>
<tr>
<td>CCI Gender Mutually Exclusive</td>
<td>The codes in Col. 2 is considered by Medicare to be gender mutually exclusive procedures of the code in Col. 1. There are no circumstances in which a modifier would be appropriate. The services represented by the code combination will not be paid separately</td>
</tr>
<tr>
<td>CCI Gender Mutually Exclusive - Modifier Allowed</td>
<td>The code in Col. 2 is considered by Medicare to be a gender mutually exclusive procedure of the code in Col. 1. A modifier is allowed in order to differentiate between the services provided. Separate payment for the services billed may be considered justifiable if a modifier is used appropriately.</td>
</tr>
</tbody>
</table>
System Administrator (All Multiple-User Versions)

The System Administrator title designates certain rights that a basic user does not have. Only the System Administrator can:

- Add Global Bookmarks and Global Sticky Notes to the system.
- Add Category Names for use with Bookmarks.
- Change the Administrator Password.
- Reset another user's password.
- Access and make changes to the User Maintenance (All Multi-User Versions) dialog box.

SYSTEM ADMINISTRATOR LOGIN

To enable the System Administrator privileges, you must log in:

1. Select Administrator Login from the File menu’s Administration submenu. The Administrator Login dialog box opens.

2. Type the Administrator password and click Login. The initial password when you first open this dialog box is Ingenix.

Note: You cannot log in as "ADMIN" from any of the suite's User Login screens. In order to obtain Administrator privileges, you have to log in as an Administrator using the password each time you launch your Encoder Pro suite product.

SYSTEM ADMINISTRATOR LOGOUT

To disable the System Administrator privileges, you must log out by selecting
Administrator Logout from the File menu’s Administration submenu.

CHANGING THE ADMINISTRATOR PASSWORD

1. Log in as the System Administrator (refer to page 121).
2. From the File menu, select Change Admin Password from the Administration submenu. The Set Password dialog box appears.

3. Type the current password in the Old Password field.

   **Note:** Each time you install an update for your Encoder Pro suite product, the Administrator password is reset to Ingenix.

4. Type your new password in the New Password and Confirm New Password fields.
5. Click OK.

   If you do not type the same text in the Confirm New Password field as in the New Password field, you are alerted via the Password Error message box.

PREFERENCES DIALOG BOX NETWORK TAB

For details on this function, refer to the Network Tab subsection under Preferences in this manual.
USER MAINTENANCE (ALL MULTI-_USER VERSIONS)

This dialog box appears when the System Administrator has logged in and selects User Maintenance from the File menu’s Administration submenu. It allows the System Administrator to delete User Names from the system. It also allows the System Administrator to rest a user password (if the user has forgotten his/her password).

Delete User

This dialog box appears only if you are logged in as a System Administrator. It is accessed by selecting Delete User from the User Maintenance dialog box. From here the System Administrator can delete any user. An important side benefit is to remind the System Administrator that deleting a user from the system also deletes any personal Sticky Notes or Bookmarks that user created.

Reset Password

Clicking this button will reset the selected user’s password to match the user’s login name. This tool is utilized by the System Administrator when a user forgets their password.
Menus

FILE MENU

<table>
<thead>
<tr>
<th>File Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print (Ctrl+P)</td>
</tr>
<tr>
<td>Opens the Print Report dialog box, which lets you print tabular results and information from dialog boxes.</td>
</tr>
<tr>
<td>Page Setup...</td>
</tr>
<tr>
<td>Opens the standard Windows Page Setup dialog box.</td>
</tr>
<tr>
<td>E/M Assistant (Ctrl+E) (EXPT and PRO only)</td>
</tr>
<tr>
<td>Opens E/M Assistant – Select Service dialog box. If you are searching for a CPT evaluation and management (E/M) code that is based on key components, the E/M Assistant helps you find the appropriate code.</td>
</tr>
</tbody>
</table>

Administration ▶ Administrator Login (All Multi-User Versions)

Opens the Administrator Login dialog box that allows you rights such as adding global bookmarks and sticky notes. The default login password is **ingenix**. You only see this option if you are not already logged in as the System Administrator.

Administration ▶ Administrator Logout (All Multi-User Versions)

Selecting this option logs you out as the System Administrator. You only see this option if you are already logged in as the System Administrator.

Administration ▶ Change Admin Password (All Multi-User Versions)

If you have logged in as an Administrator, this selection opens the Set Password dialog box that allows you to change the Administrator password.
Administration  ▶ Change Password (All Multi-User Versions)

If you are not logged in as an Administrator, this selection opens the Set Password dialog box that allows you to change your User password.

Administration  ▶ User Maintenance (All Multi-User Versions)

Opens the User Maintenance dialog box. This option is only available if you’ve already logged in as the System Administrator.

Exit (Ctrl+Q)

Closes the program.

EDIT MENU

Copy (Ctrl+C)

Copies the selected (highlighted) Code Detail code/description (depending on the preference you’ve selected) to the Windows clipboard.

Add

After selecting a code from the Code Detail, choosing this selection opens the Add Code dialog box.

Preferences

Opens the Preferences dialog box.

Select Carrier/Locality (EXPT and PRO only)

Opens the Select Medicare Carrier/Locality dialog box.
### VIEW MENU

<table>
<thead>
<tr>
<th>View</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Listing</td>
<td>Bookmarks</td>
</tr>
<tr>
<td>Sticky Notes</td>
<td>Notepad</td>
</tr>
<tr>
<td>New Codes</td>
<td></td>
</tr>
<tr>
<td>Revised Codes</td>
<td></td>
</tr>
<tr>
<td>Deleted Codes</td>
<td></td>
</tr>
<tr>
<td>CPT Color Codes</td>
<td>ICD-9 Vol. 1 Color Codes</td>
</tr>
<tr>
<td>CPT Color Codes</td>
<td>ICD-9 Vol. 2 Color Codes</td>
</tr>
<tr>
<td>CPT Color Codes</td>
<td>HCPCS Color Codes</td>
</tr>
<tr>
<td>Code Book Sections</td>
<td></td>
</tr>
</tbody>
</table>

#### Index Listing

This option is only available if you have initiated a search and there are Index Listing available. If so, this option opens the Index Listing dialog box.

#### Bookmarks

Opens the Bookmarks dialog box.

#### Sticky Notes

Opens the Sticky Notes dialog box.

#### Notepad

Opens the Notepad dialog box.

#### New Codes

Opens the New Codes dialog box.

#### Revised Codes

Opens the Revised Codes dialog box.

#### Deleted Codes

Opens the Deleted Codes dialog box.

#### CPT Color Codes (not in CIFI9)

Opens the CPT Color Codes dialog box.

#### ICD-9 Vol. 1 Color Codes

Opens the ICD-9 Vol. 1 Color Codes dialog box.
ICD-9 Vol. 3 Color Codes
Opens the ICD-9 Vol. 3 Color Codes dialog box.

HCPCS Color Codes (not in CIFI9)
Opens the HCPCS Color Codes dialog box.

Code Book Sections
Opens the Code Book Sections dialog box.

ICD-9 Vol. 1 MENU
This menu is available only when an ICD-9-CM Vol. 1 code is selected in the Code Detail. Information is specific to the currently selected code. Items not available are dimmed.

ICD-9 Section Notes
Opens the ICD-9 Section Notes dialog box.

Annotations
Opens the ICD-9 Annotations dialog box.

DRG Crosscodes (not in STND)
Opens the DRG Crosscodes dialog box.

Color Coding Legend
Opens the ICD-9 Vol. 1 Color Coding Legend.

Previous Codes
Displays the Code Detail view for the previous section of codes. Refer to Code Detail for further information.

Next Codes
Displays the Code Detail view for the next section of codes. Refer to Code Detail for further information.
ICD-9 Vol. 3 Menu

This menu is available only when an ICD-9-CM Vol. 1 code is selected in the Code Detail. Information is specific to the currently selected code. Items not available are dimmed.

- Annotations
  Opens the ICD-9 Annotations dialog box.

- ICD-9 Vol. 3 to CPT (EXPT and PRO only)
  Opens the ICD-9 Vol. 3 to CPT dialog box and only applies to ICD-9-CM Vol. 3 codes.

- DRG Crosscodes (not in STND)
  Opens the DRG Crosscodes dialog box.

- Color Coding Legend
  Opens the ICD-9 Vol. 3 Color Coding Legend.

- Previous Codes
  Displays the Code Detail view for the previous section of codes. Refer to Code Detail for further information.

- Next Codes
  Displays the Code Detail view for the next section of codes. Refer to Code Detail for further information.
CPT Menu (Not in CIFI9)

This menu is available only when a CPT code is selected in the Code Detail. Information is specific to the currently selected code. Items not available for a given code are dimmed.

- CPT Section Notes
- Lay Descriptions
- Modifiers
- Crosscoder
- CCI Unbundle Edits
- Local Medical Review Policies
- National Coverage Determinations
- Medicare Fee Schedule
- Medicare Policy
- Color Coding Legend
- Previous Section
- Next Section
- Carriers with LMRP

CPT Section Notes

Opens the CPT Section Notes dialog box.

Lay Descriptions

Opens the CPT Lay Descriptions dialog box.

Modifiers (EXPT and PRO only)

Opens the CPT Modifiers dialog box.

Crosscoder (EXPT and PRO only)

Opens the CPT Crosscodes dialog box.

CCI Unbundle Edits (EXPT and PRO only)

Opens the CPT CCI Unbundle Edits dialog box.

Local Medical Review Policies (EXPT and PRO only)

Opens the LMRP Edits dialog box.

National Coverage Determinations (EXPT and PRO only)

Opens the NCD Edits dialog box.

Medicare Fee Schedule (EXPT and PRO only)

Opens the Medicare Information dialog box.
Medicare Policy

Opens the Special Coverage Instructions dialog box.

Color Coding Legend

Opens the CPT Color Coding Legend dialog box.

Previous Codes

Displays the Code Detail view for the previous section of codes. Refer to Code Detail for further information.

Next Codes

Displays the Code Detail view for the next section of codes. Refer to Code Detail for further information.

Carriers with LMRP (EXPT and PRO only)

Opens the Carriers with LMRP Edits dialog box.

HCPCS MENU (NOT IN CIF19)

This menu is available only when a HCPCS code is selected. Information is specific to the currently selected code. Items not available are dimmed.

<table>
<thead>
<tr>
<th>HCPCS Section Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annotations</td>
</tr>
<tr>
<td>Modifiers</td>
</tr>
<tr>
<td>Crosscoder</td>
</tr>
<tr>
<td>CCI Unbundled Edits</td>
</tr>
<tr>
<td>Local Medical Review Policies</td>
</tr>
<tr>
<td>National Coverage Determinations</td>
</tr>
<tr>
<td>Medicare Policy</td>
</tr>
<tr>
<td>Color Coding Legend</td>
</tr>
<tr>
<td>Previous Section</td>
</tr>
<tr>
<td>Next Section</td>
</tr>
<tr>
<td>Carriers with LMRP</td>
</tr>
</tbody>
</table>

HCPCS Section Notes

Opens the HCPCS Section Notes dialog box.

Annotations

Opens the HCPCS Annotations dialog box.

Modifiers (EXPT and PRO only)

Opens the HCPCS Modifiers dialog box.
Crosscoder (EXPT and PRO only)
Opens the HCPCS Crosscodes dialog box.

CCI Unbundle Edits (EXPT and PRO only)
Opens the HCPCS CCI Unbundle Edits dialog box.

Local Medical Review Policies (EXPT and PRO only)
Opens the LMRP Edits dialog box.

National Coverage Determinations (EXPT and PRO only)
Opens the NCD Edits dialog box.

Medicare Policy
Opens the Special Coverage Instructions dialog box.

Color Coding Legend
Opens the HCPCS Color Code Legend dialog box.

Previous Codes
Displays the Code Detail view for the previous section of codes. Refer to Code Detail for further information.

Next Codes
Displays the Code Detail view for the next section of codes. Refer to Code Detail for further information.

Carriers with LMRP (EXPT and PRO only)
Opens the Carriers with LMRP Edits dialog box.

**UPDATE MENU**

<table>
<thead>
<tr>
<th>Updates</th>
<th>Data Updates</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Opens the Data Updates dialog box to download data sets that are specific to your Encoder Pro product.

**HISTORY MENU**

This menu displays a list of codes that you have selected during the current lookup session. The code trail shows up to 15 of the latest code selections, with the most recent at the top. Use the trail to go back to codes you’ve already searched.
HELP MENU

Coding . . .
Provides guidelines, definitions, and tips for coding with ICD-9-CM, CPT, and HCPCS codes and modifiers.

Program Help . . . (Ctrl+H)
Provides instructions on using Encoder Pro suite.

Environment Information
Opens the Environment Information dialog box.

AMA Copyright (not in CIFI9)
Opens the AMA Copyright message box.

License Agreement
Opens a printable Ingenix License Agreement message box.

Data Version
Opens the Data Version dialog box.

About . . .
Opens a splash screen that lists copyright and version information for the Encoder Pro product you purchased.
**RIGHT-CLICK ADD MENU**

This menu is available only when a code is selected in the Code Detail. Items not available are dimmed. Note that if you are using Encoder Pro Expert, the “Add to Notepad” option reads “Add to Compliance Notepad”.

<table>
<thead>
<tr>
<th>Add to Global Bookmarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to Personal Bookmarks</td>
</tr>
<tr>
<td>Add to Global Sticky Notes</td>
</tr>
<tr>
<td>Add to Personal Sticky Notes</td>
</tr>
<tr>
<td>Add to Notepad</td>
</tr>
<tr>
<td>View Carriers with LMRP</td>
</tr>
</tbody>
</table>

**Add To Global Bookmarks**

Opens the Edit Bookmark dialog box. Note that a code must be selected in the Code Detail.

**Add To Personal Bookmarks**

Opens the Edit Bookmark dialog box. Note that a code must be selected in the Code Detail.

**Add To Global Sticky Notes**

Opens the Network Sticky Notes dialog box. Note that a code must be selected in the Code Detail.

**Add To Personal Sticky Notes**

Opens the View Personal Sticky Note dialog box. Note that a code must be selected in the Code Detail.

**Add To Notepad**

Adds the selected code to the Notepad dialog box.

**View Carriers with LMRP (EXPT and PRO only)**

Opens the Carriers with LMRP Edits dialog box. Note that a code that has an LMRP or NCD edit from any carrier must be selected in the Code Detail.
Toolbar

This section highlights the buttons available from the toolbar. Note that not all buttons are available in all products. Also, an applicable code must be selected in order for some of the buttons to be available. The dependencies are listed below.

ADD

After selecting a code from the Code Detail, clicking this button opens the Add Code dialog box.

BOOKMARKS

Opens the Bookmarks dialog box.

STICKY NOTES

Opens the Sticky Notes dialog box.

NOTEPAD

Opens the Notepad dialog box. If you have Encoder Pro Expert, this button opens the Compliance Notepad dialog box.

PRINT

Opens the Print Report dialog box.

NOTES

After selecting a code that contains a note from the Code Detail, clicking this button opens one of the section notes dialog boxes (depending on the type of code selected).

ANNOTATIONS

After selecting a code that contains an annotation from the Code Detail, clicking this button opens one of the annotation dialog boxes (either ICD-9-CM Vol. 1, CPT, or HCPCS).
**MODIFIERS** *(EXPT AND PRO ONLY)*

After selecting a code that has a Modifier from the Code Detail, clicking this button opens one of the modifiers dialog boxes (either CPT or HCPCS).

**CROSSCODES** *(EXPT AND PRO ONLY)*

After selecting a code that has a crosscode from the Code Detail, clicking this button opens one of the crosscodes dialog boxes (either ICD-9-CM Vol. 3, CPT, or HCPCS).

**CCI UNBUNDLE EDITS** *(EXPT AND PRO ONLY)*

After selecting a code that has a CCI Unbundle associate with it from the Code Detail, clicking this button opens one of the CCI Unbundle Edits dialog boxes (either CPT or HCPCS).

**LMRP EDITS** *(EXPT AND PRO ONLY)*

After selecting a code that has a Local Medical Review Policy Edit from the Code Detail, clicking this button opens one of the LMRP Edits dialog boxes (either CPT or HCPCS).

The LMRP button is active only if there are edits for the selected code and carrier preference and/or if NCD edits exist for that code.

**NCD EDITS** *(EXPT AND PRO ONLY)*

After selecting a code that has a NCD edit associate with it from the Code Detail, clicking this button opens one of the NCD Edits dialog boxes (either CPT or HCPCS).

The NCD button is active only if there are edits for the selected code.

**CMS FEE SCHEDULE** *(EXPT AND PRO ONLY)*

After selecting a CPT code that has a Medicare Fee Schedule from the Code Detail, clicking this button opens the Medicare Information dialog box.

**CMS POLICY** *(NOT IN CIFI9)*

After selecting a code that has special coverage instructions from the Code Detail, clicking this button opens one of the Special Coverage Instructions dialog boxes. The term “CMS” on this button refers to the Centers for Medicare and Medicaid Services (CMS).

**DRG CROSSCODES** *(NOT IN STND)*

After selecting an ICD-9-CM code in the Code Detail that has a DRG Crosscode, clicking this button opens the DRG Crosscodes dialog box.
COLOR CODING LEGEND

Opens the applicable Color Code Legend dialog box depending on which type of code is selected.

HELP

Opens online help.